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Avant-propos

Grace a la geéneéralisation des aspects de “Cloud-computing” de nombreux services et
applications de qualités sont maintenant disponible sur le web. Dans cette optique, il est
intéressant de se poser la question lors du choix des différents outils et services a utiliser pour
gérer la plupart de ses documents numeérique. Le choix d'une suite bureautique fait
notamment partie de la donne.

Dans ce secteur, les solutions de Google sont une véritable alternative en comparaison des
suites comme la suite Office de Microsoft ou encore les solutions libres OpenOffice ou Libre
Office. Google propose ainsi des services simple, efficace, d'une grande qualité et cela
gratuitement pour les particuliers.

Ainsi Je vous propose dans ce guide de decouvrir en détail les applications bureautique de

Google pour utiliser et maitriser pleinement les outils.

Préconisation : afin de profiter pleinement des applications de Google, je vous conseille
d'utiliser le navigateur Chrome qui est compléetement optimise pour ces outils.

Cependant, rien ne vous empéche d'utiliser d'autre navigateur comme Firefox, Safari ou
encore Edge (Le remplacant d'Internet Explorer).

Information : Pour aller plus loin avec les Gsuite, je vous propose egalement sur la chaine
Youtube NumeriTube
(https.//www.youtube.com/channel/UCuV\Wopl83QgawEaNepFlh7A) des tutoriels avec
des cas pratiques. Ces cas permettent notamment de mettre en application les différentes
fonctionnalités présentes dans ce document.
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https://www.youtube.com/channel/UCuVW0pl83QgawEaNepFlh7A
https://www.youtube.com/channel/UCuVW0pl83QgawEaNepFlh7A

Google Drive : Gerer et stocker ses documents

Pour utiliser pleinement des applications bureautique Google, je vous conseille de
commencer par créer un compte Google Drive. Voici avant de vous lancez une petite
présentation de l'outil de gestion et de stockage en ligne de Google.

Information : Google Drive ne sera pas vu en deétail dans ce livre afin de développer
pleinement les outils bureautique et leur utilisation. L'introduction a Google Drive a
comme objectif de vous donnez une vision “globale” de la solution.
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Google Drive c'est quoi ?

Le service Google Drive est un espace de stockage de type “Cloud” qui vous permet de
disposer d'un espace de stockage gratuit de 15Go (pour les particuliers avec une adresse
Gmail.com) ou 30 Go/illimité pour les entreprises, associations, ecoles, afin de sauvegarder
vos donnees sur internet. Grace a cette solution, vous pouvez garder vos documents ou une
copie de vos documents en sécurité sur le Cloud.

Creation et edition de documents

Grace au Drive, vous pouvez créer, editer et gérer les fichiers bureautique de Google que
nous allons développer dans ce livre. Vous n'avez ainsi besoin d'installer aucun logiciel sur
votre PC ou votre Mac pour créer des documents bureautique.

Information : Il est également possible d'éditer de facon basique des fichiers de la suite
Office Microsoft depuis le Drive. Il faut cependant ajouter une extension a Google Chrome
(editeur office pour docs sheets and slides).

Partage et collaboration

L'une des grandes force de la suite bureautique de Google se trouve dans les nouveautées en
termes de collaboration et de partage. Vous pouvez ainsi grace a ces fonctionnalité
partager et éditer simplement des documents Google avec vos ami(e)s ou vos collegues
de travail.

Nous développerons plus ces aspects lors de la decouverte des applications dans les
chapitres suivants.
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https://chrome.google.com/webstore/detail/office-editing-for-docs-s/gbkeegbaiigmenfmjfclcdgdpimamgkj?hl=fr
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Comment creer un compte Drive ?

Pour créer un compte Google Drive, il vous suffit de faire une recherche sur internet avec les
mots clés “Google Drive" ou encore depuis 'URL suivante :

https.//www.google.com/intl/fr_fr/drive/ est de suivre la procédure pour créer votre
compte gratuitement.

Google

Tout Google avec un seul compte

Connectez-vous a votre compte Google.

Saisissez votre adresse e-mail ‘

Besoin d'aide ?

Créer un compte

Tout Google avec un seul compte

GMEBROL *HE
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https://www.google.com/intl/fr_fr/drive/

Google Docs : Traitement de texte

Environnement de Google Docs

Google Docs est une solution de traitement de texte qui vous permet de créer des
documents dans une interface épurée et simple d'utilisation. Vous pouvez grace a cette
solution créer des documents, les mettre en forme grace a un large choix de paramétres et
de fonctionnalites.

Outre laspect de traitement de texte, vous pouvez grace a Google Docs partager tres
facilement vos documents et ainsi collaborer plus efficacement avec vos collegues.

Afin d'utiliser cette solution au mieux, nous allons voir dans ce document comment
fonctionne un document Google de base est voir en détail la plupart des fonctionnalités
présentes.
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Composition d'un document Google Docs

Un document Google Docs est de plusieurs zone distinctes. En plus du titre du document, il
est possible de découper les zones en 4 parties développees ci-dessous :

- La barre de menu permet de chercher plus en détails diverses fonctionnalités :

Fichier Edition Affichage Insertion Format Outils Tableau Modules complémentaires Aide  Demiére modification il y a 42 minutes

- La barre d'outils permet de modifier votre texte ou la mise en forme rapidement. Cette
barre peut vous proposer des options différentes selon l'emplacement de votre
sélecteur (Tableau, image, etc.). Vous pouvez egalement choisir le mode d'acces du

document (Edition, Suggestion, affichage)

il
4

1
4

0
il
il
=

= e o~ " 100% - Normal . Arial - 9 - B I U A~ coH 1
i

- La régle de mise en page qui permet de visualiser et de modifier lemplacement des
marges, retraits et des tabulations.

1 1 2 3 4 5 8

- La zone de collaboration vous permet d'ajouter des commentaires de partager sur le
document ou encore de modifier le mode d'édition (Edition, Suggestion, Affichage).

LsoCumeny sans e =

ﬂ Foitim  Elitas  Afibage iniates  Fome Ol Toieis  Mokses (amphimsied - A =

&P e S— %, i, " B A - e ompum - E-E-a@ L e ¥

A=
| Barre d'outils | Barre des menus Zone de
! o collaboration

[Regla de mise en |
page )
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Enregistrement d'un document

Sur les document Google (Docs, Sheets, Slides, etc.) Uenregistrement se fait
automatiquement. Vous n'avez ainsi plus a vous inquiétez de cette tache recurrente et
sensible.

Mode plein eécran et compact

Pour consulter votre document sans la barre d'outils ni les menus, procédez comme
ci-dessous :

- Affichage compact : menu Affichage > Mode Compact ou la combinaison Ctrl*Maj+*F.

- Affichage plein écran . menu Affichage > Plein écran (Echap pour revenir a l'état initial).

Information : Vous pouvez également cliquez sur le touche F11 de votre clavier pour
afficher votre fenétre en plein écran eégalement. (Appuyez sur Echap pour quitter ce mode).
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Manipulation et notion de base

Créer un document

Dans Google Drive, cliquez sur Nouveau, puis sélectionnez Google Docs. Un nouveau
document Google va alors s'ouvrir dans votre navigateur. Vous pouvez a présent le modifier.

| Dossier

Importer un fichier

Importer un dossier

I B Google Docs '{b

Renommer un document

Cliquez sur Document sans titre pour donner un nom a votre document. (Vous pouvez
modifier le nom du document a tout moment en cliquant sur le titre).

Document sans fitre
thmdlﬁiaiﬁﬁlﬁm e
I el A00% -

Créer un document a partir d'un modele

Si vous souhaitez utiliser un modele pour créer plus rapidement un document, procedez
comme suit :

1. Ouvrez un nouveau document Google Docs.
2. Faite ensuite Fichier > Nouveau > A partir d'un modéle.

3. Il ne vous reste alors plus qu'a choisir un modele depuis la liste présente dans la
nouvelle fenétre affichee a l'écran.

4. Cliquez sur Utiliser ce modéle pour l'appliquer a votre document.

B Document texte
Feuille de calcul
| Présentation
B Formulaire

B3 Dessin

A partir du modéle. .
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Mise en forme du document

Modification de la couleur du texte et de l'arriere plan
Pour modifier la couleur de texte ou l'arriére plan d'un document :

1. Mettez le bloc de texte concerné en surbrillance.

2. Cliquez sur le bouton depuis la barre d'outils.

3. Sélectionner ensuite Texte ou Arriére-plan et choisissez la couleur.

A- e B =
—

Texte Arrigre-plan
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Taille et espacement du texte

Pour modifier la taille du texte, sélectionnez celui-ci et cliquez sur le bouton [ =
precisant la taille actuelle (11pt par defaut).

Pour modifier linterligne du document ou ajouter un espacement avant ou aprés un

paragraphe, cliquez sur le bouton présent dans la barre d'outils.

Normal ‘E} Open Sans -
¥ MNormal >
i D | 120
NS s ) i
L= Titre
Simple
1,15 L
£ Sous-titre
Double -
Titre 1
Insérer un espacement avant le paragraphe
Supprimer l'espacement aprés le paragraphe Titre 2
LI
Espacement personnalisé...
Titre 3
Titre 4
Options
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Styles de paragraphes et titres

Le menu Styles présent dans la barre d'outils affiche le style du texte sélectionné dans un
document et vous permet de le modifier ou de supprimer la mise en forme.

Pour afficher la liste des titres, cliquez sur le menu qui se trouve a gauche du menu Police
de la barre d'outils ou cliquez sur Format > Styles de paragraphe.

Sélectionnez ensuite l'un des styles proposes, classés de "Titre 1" (le plus grand) a "Titre 6"
(le plus petit).

Pour modifier la mise en forme d'un Titre, commencer par modifier la mise en forme du
texte a modifier, puis faite un clic-droit > Mettre a jour “Titre 1" en fonction de la sélection...

Appliquer un format existant
Pour appliquer un format déja existant d'un bloc de texte a un autre, procédez comme suit :

1. Sélectionnez le bloc de texte a modifier.

2. Cliquez sur le bouton .
3. Puis sélectionnez le bloc de texte ou appliquer la mise en forme.

Pour appliquer le méme format a plusieurs parties d'un document, double-cliquez sur le
bouton avec le rouleau de peinture pour activer et appliquer la mise en forme plusieurs fois
de suite. Pour désactiver, cliquez a nouveau sur le bouton.

Ajouter des Listes a puces, des numerotation, des retraits

== .= E |

Afin de rendre votre document plus clair et lisible, vous avez la |~
possibilité d'ajouter des listes a puces, des numérotation ou encore | N ; e
des retraits a certaines parties d'un document Google Docs. b. - o 1:12?21

2 2) 2
Il vous suffit pour cela de sélectionner l'une des ces possibilites | - =
depuis la barre d'outils. » = >

B i Il i 0z, I
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Insertion d'éléments

Insérer un lien

Pour ajouter un ou des lien(s) dans un document Google Docs, il vous suffit de proceder
comme suit :

1. Sélectionnez le contenu (texte, image, etc.) auquel vous souhaitez associer un lien.
2. Cliquez sur l'icone de lien [22]dans la barre d'outils ou clic-droit > lien ou Ctrl + K

3. Saisissez maintenant l'URL de destination ou faite une recherche sur le web depuis
ce méme champ.

4. Enfin cliquez sur Appliquer.

d'un lien de test.

Texte lien

Lien ‘ Coller un lien ou effectuer une recherche

Lien - Wikipedia, the free encycl...
= https:ien wikipedia. org/wikilLien

w1 ien Definitinn | Investnnedia

Information : Vous pouvez par lintermédiaire d'un lien faire référence a différents types de
contenu comme une page internet, un autre document (Docs, Sheets, Slides, etc.) ou
encore un chapitre précis de votre document.
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Insérer des images

Si vous souhaitez insérer une image et la mettre en forme dans votre document, proceder
comme suit :

1.

2.

Cliquez sur Insertion > Image.

Sélectionnez une image. Vous pouvez importer une image depuis votre ordinateur, en
seélectionner une dans Google Drive ou vos albums photo, en rechercher une image sur
le Web ou prendre un instantané. Une fois l'image ajoutée, vous pouvez la supprimer

ou la redimensionner a tout moment.

. Pour supprimer une image, sélectionnez la, faites un clic-droit (ou

cliquez sur Edition), puis choisissez Couper ou cliquez sur la touche
‘Suppr.”

Pour redimensionner une image, cliquez dessus, puis faites glisser
l'une des poignées de sélection. Utilisez les poignées d'angle pour
redimensionner une image tout en en conservant les proportions.

:
8

Aligner | Envelopper | Intercaler

Utilisez les poignées du haut, du bas ou latérales pour modifier une seule dimension.

Vous pouvez enfin intégrer votre image de difféerentes facon dans le document

(Aligner, Envelopper, Intercaler).
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Ajouter une bordure a une image

Pour ajouter une bordure a une image, cliquez sur celle-ci et utilisez Lles options disponibles
depuis la barre d'outils. Dans ce cas, il ne suffit que de sélectionner une couleur et une taille
de bordure.

L -=-=- 'EI: Q Options de I'image... = Remplacer I'image...

Insertion d'autres contenu

Vous pouvez egalement insérer d'autres types de contenu dans votre document Google
Docs. Voici la liste des éléments qu'il vous est possible d'insérer depuis le menu Insertion
présent dans la barre d'outils :

- Equation. e
- Dessin: depuis l'application Google Drawings i Bt
- Tableau: ‘developpe plus bas dans le document.. &3 Dessin...
Tableau
- Note de bas de page : pour des références externes.
- Caractéres spéciaux. Note de bas de page Ctrl+Al+F

. . E té SCia. ..
- Ligne horizontale. e e

— Ligne horizontale

-  Numéro de page/Nombre de page.

Numéro de page

MNombre de pages

- Saut de page : atteindre directement la page suivante.

. . M Saut de page Ctri+Enter
- En-téte/Pied de page. En-téte Ctri+Alt+0 Ciri+Al+H
- Signet : raccourcis vers un emplacement du document. Fizldopam SRR CREARE
Signet
- Table des matiéres : insertion d'une table avec tous les Table des matiéres

titres.
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Tableaux et encadrements

Nous allons voir dans cette partie les différentes notions autour des tableaux et des
encadrements. En effet, pour le moment la seule facon de mettre en place des encadrements
dans Google Docs est de passer par l'utilisation de tableau.

Ajouter un tableau

Tableau Modules complémentaires  Aide T

Les tableaux constituent un excellent moyen d'organiser les
informations de votre document.

| Insérer un tableau s |

Pour insérer un tableau dans votre document, procéder I
comme suit :

1. Cliquez sur Tableau > Insérer un tableau.

2. Indiquer le nombre de lignes et de colonnes souhaitees.

Information : Pour colorer les cellules (comme la ligne superieure ci-dessus), sélectionnez
le texte d'une ou plusieurs cellules, cliquez sur Tableau > Propriétés du tableau, puis
définissez la couleur d'arriere-plan des cellules.
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Fusionner les cellules d'un tableau

Fusionner les cellules

Pour fusionner les cellules d'un tableau dans votre document {
. . . . . Propriétés du tableau...
Google Docs, il vous suffit de sélectionner les cellules a
fusionner et de faire un clic-droit et de sélectionner “Fusionner el ,
Mettre a jour "Normal” en fonction de
leS CeuuleS" Ty Effacer la mise en forme

Sélectionner tout le texte corresponds

Pour annuler la fusion, selectionner les cellules concernées, puis
clic-droit et “Défusionner les cellules”.

Redimensionner un tableau

Pour redimensionner un tableau, il vous suffit d'utiliser le sélecteur en placant votre souris
sur l'une des lignes ou colonnes de votre tableau. Rester ensuite cliquez avec le clic gauche
de votre souris et déplacer la lighe ou la colonne comme bon vous semble.

Vous pouvez egalement définir plus precisement la taille de votre tableau avec clic-droit >
Proprietes du tableau...

Dimensions (centimétres)

v Largeur de colonne 5292

Hauteur de ligne minimale [}

I Marge intérieure des cellules  0.176

Alignement du tableau

Gauche 3

Retrait & gauche
(centimétres)

1.005
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Définir le style des cellules

Vous pouvez egalement définir un style spécifique aux différentes bordures et cellules de

votre tableau.

Pour modifier les contours d'une cellules, placez votre sélecteur dans une cellule puis

modifier la mise en forme avec les icones de tableau présentes dans la barre d'outils.

Pour modifier simplement le contour du tableau, sélectionner celui-ci et faite un clic-droit >

Proprietes du tableau...

-/

 — gy mEm

Bordure du tableau

.v 1pt ~

Couleur d'arriere-plan des cellules

Alignement vertical des cellules

Haut =
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Parametres de page et Impression

Table des matieres / Plan de document

Plan >
Pour afficher le plan de votre document (table de matiere), cliqQuUezZ | sommaie
sur Outils - Plan du document. P
. . . , . . . Google Drive : Gérer et stocker ses d...
Vous pourrez alors visualiser les différents titre enregistrer depuis Tab
. . Google Drive c'est quoi 7
un menu défilant a gauche de votre texte. ] ] i
omment créer un compte Drive 7
. . Google Docs : Traitement de texte Vous
Pagination et sauts de page e

Environnement de Google Docs :
Rea

Depuis Google Docs, vous pouvez afficher vos documents sous - ariiaion stacion sa basa

deux formats différents qui sont affichage paginé et affichage

compact. Ces types d'affichages permettent d'avoir une meilleure idée de ce a quoi
ressemblera votre document une fois imprime.

Par défaut, un document se trouve en affichage paginé. Pour modifier l'affichage, cliquez sur
le menu Affichage > Mise en page. Vous passerez alors automatiquement en affichage
compact.

Notes de bas de page et pagination

En affichage paginé, les notes apparaissent comme elles seront imprimées en bas de la
page. Pour voir une note de bas de page, double-cliquez sur le numeéro de la note
correspondant dans le corps du document.

En affichage compact, les numéros des notes de bas de page apparaissent dans le corps du
document mais les notes sont masquees en bas de chaque page. Si vous insérez une note de
bas de page depuis ce mode, vous passerez automatiquement en mode d'affichage paginé.
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Insertion de saut de page

Pour insérez un saut de page afin de travailler sur la page suivante, cliquez sur le menu

insertion > Saut de page.

b
- Saut de page {b Ctri+Enter !

Fn-téte Ctol+ A+ 0 Cid+AR+H

Pour supprimer un saut de page selectionnez-le et appuyez sur la touche “Retour arriére” ou

llsuppr".

Information : Lorsque vous modifiez le type d'affichage (paginé > compact) ce parameétre

est alors enregistré par défaut dans tous les documents que vous ouvrirez par la suite.
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Configuration de la page

Pour configurer et contrdler précisement l'emplacement de votre texte sur votre document.
Vous pouvez définir lemplacement du texte depuis la régle présente en haut de votre
document, qui vous permet de définir des marges, des retraits et des tabulations :

T " =

Les marges

Les marges définissent la mise en forme de tout le | configuration de ta page
document.

Orientation Marges (centimétres)

® Portrait Paysage Haut 127

Vous pouvez la modifier depuis la regle vu précédemment
ou encore depuis le menu Fichier > Configuration de la

page.

Format de papier Bas 127

Lettre (21,6 x 279 cm) * a h §57
auche B

Couleur de la e
e Droite | 1.27

Lorsque vous avez personnalisé vos marges, vous pouvez
cliquer sur Définir comme valeurs par défaut pour adapter o |
cette mise en page a tous les nouveaux documents que
vous allez créez.

Annuler Définir comme valeurs par défaut

Les retraits

Les retraits peuvent étre modifies au niveau des paragraphes. Pour régler le retrait pour
plusieurs paragraphes, sélectionnez le texte approprie et définissez le retrait voulu.

- Retrait de la premiére ligne : Le petit rectangle sur la regle qui permet d'ajuster la
position de départ d'un paragraphe et peut étre modifié pour chaque paragraphe.

- Retrait a gauche : s'applique a la deuxieme lignhe d'un paragraphe, ainsi qu'aux
suivantes. Pour le controler, faites glisser le triangle pointant vers le bas le long de la
regle.

- Retrait a droite : retrait controlé a laide du triangle pointant vers le bas place a
l'extrémité droite, définit la longueur d'un paragraphe jusqu'au bord droit de la page.
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Numeéro et nombre de page

Pour ajouter un des numéros de page a votre document, cliquez sur le
menu Insertion > Numeéro de page et sélectionnez l'une des quatre
Les numeéros de pages seront alors ajoutés

propositions présentes.
automatiquement.

Pour supprimer un numero de page, cliquez directement sur la zone de
numerotation et puis supprimer les numeros.

Pour ajouter le nombre de pages préesentes dans un document, placez vous tout d'abord a
l'endroit ou vous souhaitez voir apparaitre le nombre (en-téte, pied de page) et cliquez sur le

menu Insertion > Nombre pages.

Parametres de zoom

Pour régler le paramétre de zoom, il vous suffit de cliquez sur le bouton
sélectionnez le pourcentage d'affichage qui vous convient le mieux.

Imprimer

Total : B Baiie N el ol S

Destination

Pages

Copies

Taille du
papier

Marges

Options

[ imprimer ISR

=
[ e = oy EE

| Modifier... |

s Tous

Ad -

Par défaut -

[] En-tétes et pieds de page
| Recto verso

|| Graphiques d'arriére-plan

Imprimer via la boite de dialogue du systéme...

(Ctrl+Shift+P)

m et de
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Impression et telechargements

Si vous avez besoin d'imprimer ou de télecharger un document Google Docs, vous en avez la
possibilité en procédant comme suit :

Mise en page et impression

Pour imprimer, vous pouvez soit cliquer sur le bouton imprimante dans la barre d'outil ou
encore faire Fichier > Imprimer. \/ous aurez alors la fenétre de parametres d'impression qui va
s'afficher.

[y : " : estination Ly e Rl
Vous pouvez notamment personnalisé le résultat de l'impression | 7™
Maodifier...
. . L. » . Pages () Tous
- Destination : Choisir limprimante par sur laquelle
imprimer. 2
- Pages : Imprimer toutes les pages ou une parties. Siie 1 el
- Taille du papier : Choix du format d'impression. Options 9 Rectoverso
- Marges : Choix du type de marges. 4  Plus de paramétres

- Options : Activer ou non des options comme les entétes et | | .. oot de distosue du sysieme.,
pieds de page, limpression recto-verso ou encore les | (Cui=shifi-?)
graphiques d'arriere-plan.

Telechargement
Microsoft Word (.docx)

Vous pouvez egalement télecharger votre document Google Docs en Format OpenDocument (_odt)

different format. Format texte enrichi { rtf)

. . . g Iy Document PDF (_pdf)
Il vous suffit pour cela de faire Fichier > Télécharger au format et de

sélectionner le format souhaité.

Texte brut (_txt)

Page Web (html, zippe)
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Revision et historique des fichiers

Si vous souhaitez voir les modifications apportés a un document par vous ou d'autres
personnes, vous pouvez consulter lhistorique des révisions. Celui-ci vous permet de
consulter et de rétablir des versions préecedentes du fichier, mais egalement de voir qui a
apportée les dernieres modifications.

Historique des revisions

Pour consulter lhistorique des révisions et ainsi visualiser les
différentes versions de votre document, cliquez depuis la barre de

. . = . PR Aujourd'hui, 11:42
menu sur Fichier > Consulter U'historique des revisions. Vous pouvez || u =
egalement acceder a ce menu en cliquant sur le bouton a droite du g,
menu “Aide” ou encore avec le raccourci clavier “Ctri+Alt+*Maj+G”. Aujourdhui, 1134

i

Vous allez alors pouvoir visualiser et selectionner lune des | | Auoudhi 11:19
différentes versions du document en sélection la date et I'heure . e
indiqué sur le panneau a droite. En dessous figure également le A Aficheries monfcamons

nom des personnes a l'origine des modifications. ikt

Les fleches en haut a droite vous permettent également de faire défiler les modifications par
ordre chronologique. Le modification apparaitront alors dans une autre couleur que la couleur
d'origine et le texte supprime en barre.

& Historique des révisions
Aujourdhui, 13:29
Total : 1 medification Historique des révisions

e Aujourd'hui, 13:29
n
o= - Aujourdhui, 11:45
’ | |

Aujourd'hui, 09:29
[ ]

18 aoiit, 13:24

W P et

Pour rétablir une version, il vous suffit de cliquez sur Restaurer cette version apres avoir
sélectionné la date en question. Pour revenir a la version actuelle, cliquez sur la fleche de
retour en haut a gauche de 'écran.

Information : Lors de la restauration d'un document a une date antérieure, vous n'écrasez
en aucun cas les versions plus récente. Cette version viendra simplement ce placer en haut
de liste de l'historique des versions.
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Afficher les dernieres modifications

Dans le cas ou vous travaillerez avec d'autres personnes sur un document, vous pouvez
afficher les dernieres modifications apportées, cliquez depuis la barre de menu sur Fichier >
Voir les nouvelles modifications.

Utilisez ensuite les fleches présentes en haut a droite pour
faire défiler la liste des modifications. Vous pourrez alors Total - 9 modifications =~ A W
visualiser les modifications en surbrillance. Le texte supprimée
sera barré.

Information : Pour le moment cette fonctionnalité n'est pas disponible pour les documents
de type Sheets & Slides.

Impossible d'afficher une version précedente

Dans certains cas les révisions de votre fichier peuvent étre fusionnées afin d'économiser de
l'espace de stockage. Généralement lorsque le fichier est ancien ou lorsque les révisons
prennent beaucoup d'espace de stockage.

Information : Il est uniquement possible d'utiliser ['historique des révisions si vous avez
acces en modification au document. Les utilisateurs en lecture ou commentaire n'y ont pas
acces.
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Partage et collaboration

Partagez votre document Google Docs avec d'autres
personnes et profitez des fonctionnalités collaboratives de Commentaires | WCREULE LS
celui-ci. Plusieurs personnes peuvent modifier un document
Google Docs simultanément.

# Edition |

Pour partager votre fichier Docs, cliquez sur le bouton Partager en haut a droite de la page.
Pour en savoir plus sur les parameétres de partage, consultez le document Partager et
collaborer.

Commentaires et discussions

Une fois qu'un document est partage avec une ou plusieurs autres | iies Aide  Toutes les modific
personnes, vous avez la possibilité d'échanger des informations = =
- co

. u
directement sur le document. s [
Insérer un commentaire (Ciri+Alt+M) §

Cette fonctionnalité et tres intéressante afin d'avoir l'avis d'autres
personnes sur son contenu.

Ajouter un commentaire

Pour ajouter un commentaire sur une partie de texte ou méme simplement un terme
sélectionner d'abord la partie concernée puis vous pouvez choisir lune des méthodes
suivantes pour afficher la fenétre de commentaire :

- Cliquer sur le bouton 1= depuis la barre d'outils menter” pour =

- Menu Insertion > Commentaires.

- Combinaison de touches “Ctrl+Alt+M",

Saisissez votre commentaire dans la fenétre qui s'affiche puis cliquez sur “*commenter” pour
enregistrer le commentaire.

Modifier ou supprimer un commentaire

Pour modifier ou supprimer un commentaire, il vous suffit de ’ 50 Auowra. | E I\
cliquez sur les trois points verticaux et de sélectionner l'option | iest wogiier
souhaitee. Supprimer

Lien vers ce commentaire. .
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Envoyer un commentaire a une personne spécifique

Pour envoyer une remarque a une personne determinée, lors de 'écriture de votre message
dans la zone de commentaire, ajoutez un signe “+" suivi de l'adresse e-mail de la personne
a qui vous souhaitez adresser le message. Ex : +john.doe@gmail.fr.

Répondre ou fermer des commentaires

Vous pouvez répondre a des commentaires ajoutes par
d'autres personnes ou encore fermer les discussions
lorsque celle-ci sont terminées.

Pour répondre a un commentaire, il vous suffit de
sélectionner le commentaire en question et de cliquez sur
la zone de texte. Vous aurez alors acces a une zone
“Répondre” pour ajouter votre réponse.

Pour fermer un commentaire, sélectionner le commentaire
puis cliquez simplement sur “Fermer la discussion”.

Recevoir une notifications des commentaires

Iﬁ L& |
i 15:04 Aujourdhui

[ b
= F
15.04 Aujourd'hui ikt
test

commentaire

Annuler

Pour recevoir une notification par mail lorsque d'autres utilisateurs laissent un commentaires

dans un fichier Google Docs, il faut procéder comme suit :

1. Cliquez sur Commentaires en haut a droite du document.

2. Cliquez sur Notifications.

3. Choisissez alors un parameétre de notification pour définir la fréequence vous souhaitez
recevoir des mails (Tous les événements, réponses pour vous, désactivées).
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Astuces et notions diverses

Recherche / Remplacement

Pour rechercher des informations précise dans un
fichier Google Sheets, dans la barre de menu cliquez

Rechercher et remplacer

Rechercher edition|

sur Edition > Rechercher et Remplacer (Ctrl+H). Remplacer par

Depuis la fenétre qui va s'afficher, vous allez pouvoir
recherche des éléments dans tout le fichier ou

Respecter la casse

Remplacer Tout remplacer

< Préc. Sulvﬁl »>

encore remplacer des mots. Pour cela, noter le mot a

remplacer dans “Rechercher” et le nouveau mot | Recherher o
"Remplacer par". Remplacer par = Feuilles

Il ne vous reste plus qu'a remplacer les mots au fur et

Respecter la casse

a mesure “Remplacer” ou tous les mots d'un clic | | Remelacer  Toutrempiscer

N

< Préc.

Suivant »

“Tout remplacer”.

Veérifier 'orthographe dans un document

Pour vérifier si votre fichier Docs ne présente pas des
fautes d'orthographes et avoir des suggestions de
correction, utilisez le correcteur orthographique.

1. Cliquez sur la cellule ou les plages de cellules a
verifier.

2. Dirigez vous vers la barre de menu Outils >
Orthographe.

Remplacer REGIONS par : b4
REGIONS Rempiacer -
v REGIONS Ignorer =

REG IONS ! Ajouter au diction... =~
REG-IONS

3. Si le correcteur trouve un mot qui lui semble incorrect, il va vous proposez de le
remplacer. Si vous le souhaitez vous pouvez evidemment Ignorer la proposition.

4. Pour terminer la vérification cliquer la croix X,

Rechercher des fonctions

Pour trouver rapidement une fonctionnalité ou autre
depuis Google Docs, vous pouvez utiliser la fonction de
recherche présente dans la barre de menu > Aide.

Aide | Toutes les modifications enregistrées dans Drive

| taille

= |

Augmenter |a taille de la police

Diminuer la taille de la police
Taille de police : 8

Taille de police : 5

Taille de police : 10

Taille de police : 11

Ctrl+Maj+,

Ctrl+Maij+.
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Rechercher des éléments externe

Vous pouvez depuis Google Docs intégrer des documents externe directement depuis
l'application. Pour cela, il vous suffit de cliquez depuis la barre de menu sur Outils >
Recherche.

I} i T R Recherch
Un volet va alors apparaitre sur la droite de votre ["

ecran depuis lequel vous allez pouvoir chercher B< > \E\ﬁj
différents éléments a intégrer depuis internet, ou =
encore depuis votre Drive. o

Images

Fonction tres intéressante notamment pour | & coogle scholar

trouver des images a integrer. Celle-ci sont de
plus libre de droit.

99 Citations
E Dictionnaire

Tableaux

Utiliser la saisie vocale

Vous pouvez egalement depuis Google Docs utiliser la saisie vocale X
(Outils > Saisie vocale) qui vous permet de dicter votre texte a haute voix .

qui sera ensuite retranscris en texte sur votre document. N\ J]
Lors de la premiére utilisation de cette fonctionnalité, il vous faudra tout R

d'abord autoriser l'outil a utiliser votre microphone. Cliquer pour parler

Recuperer le texte d'une image

Avec Google Docs, vous pouvez recuperer le texte présent sur une image (ou un document
PDF) afin de l'éditer simplement sur un documents Docs. Tout cela grace au systeme de
reconnaissance de caractere (OCR).

Pour utiliser cette fonctionnalité, procédez comme suit :

1. Transférer une image avec du texte sur votre =
espace Google Drive Ma,‘[trlser les outils
2. Faite un clic-droit sur le fichier burea u-tiq ue de
3. Ouvrir avec Google Docs Goog|e
4. Un fichier Docs va alors étre créé avec l'image
et le texte éditable. Maitriser les outils bureautique de
GOOGLE|
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Ajouter un Filigrane (image/texte arriere plan)

Il n'est actuellement pas possible d'utiliser la fonction Filigrane depuis Google Docs.
Cependant, pour contourner le probleme, vous pouvez utilisez la solution de dessin de
Google (Drawings).

Cette méthode est hotamment largement suffisante dans le cas d'un filigrane d'en-téte ou de

bas de page. Par exemple dans le cas ou l'on souhaite ajouter une image avec du texte par
dessus, il faut procédez comme suit :

1
2.

3.

Cliquez sur Insertion > Dessin.
Charger alors votre image de fond avec l'icdne image .

Une fois limage chargé intégrer une zone de texte par dessus et noter le
contenu

Il ne vous reste alors qu'a cliquez sur “Enregistrer et fermer”.

limage chargée ainsi que la zone de texte vont alors étre intégrées a votre document
par l'intermédiaire d'une image.

Dessin Enregistré automatiquement & 10:18:24
Actions- e~ A @ - RN -Qg- T - L -=-F - Autres -

Filigrane Google Docs
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Modules complémentaires

Les modules complémentaires sont en quelque sortes des “extensions” pour Google Docs.
Vous pouvez ainsi grace a ces modules améliorer et augmenter le potentiel de Docs. Voici

ci-dessous des exemples de modules qu'ils peut-étre intéressant d'installer.

Modules complémentaires

Tous ¥

url
shortener

URL Shortener

21 850 utilisateurs

AV

My nset Music

ig,"f’p! IEIJ;-‘T] =

==
VexTab Music Notation

94 134 utilisateurs

hello JE

¢

Label Merge

w TRY IT FREE
VeritySpell

VeritySpell HelloFax
42 621 utilisateurs 48 142 utilisateurs

Avery Label Merge
urs

118 683 utilisateurs

Information : pour installer des modules directement depuis Google Docs, il vous suffit de
cliquer depuis la barre de menu sur Module complémentaires - Télécharger les modules
complémentaires.

Gestion des etiquettes sur Google Docs

La gestion d'étiquette n'est actuellement pas disponible en natif sur Google Docs. Cependant
grace au modules “Avery Label Merge”, il est possible de gérer limpression des etiquettes
aussi bien (voir mieux) que sur la solution \Word de Microsoft.

Publipostage - Mailing (Google Docs/Sheets)

Le publipostage n'est actuellement pas disponible en natif sur Google Docs. Vous pouvez
cependant utiliser des modules complémentaires comme *“autoCrat” pour faire du
publipostage.

Realisation de CV

Si vous souhaitez realiser simplement votre CV, le module complémentaire “VisualCV
Resume Builder” vous permet de disposer d'un grand nombre de modeles (templates) pour
réaliser simplement et efficacement le déroulé de votre parcours professionnel.

337125



Google Slides : Presentation

Environnement de Google Slides

Google slides est une solution de création de diaporama qui vous permet de créer des
modeles de présentation simple et efficace. Vous pouvez notamment les modifier et travailler

sur des présentations a plusieurs.
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Composition d'une présentation Google Slides

Un fichier de présentation Slides ressemble beaucoup aux solutions les plus connus comme
la solution de Microsoft PowerPoint.

La plupart des fonctionnalités “de base" sont actuellement disponible sur cette version. Nous
allons pour débuter, voir en détails comme se présente un fichier Google Slides vierge.

Barre des menus : Toutes les commandes disponibles sont accessible depuis ce
menu.

Barre d'outils : Permet de lancer des commandes avec un simple bouton.

Zone de visualisation des diaporamas : Permet de visualiser les diaporamas en
miniature dans l'ordre de défilement.

Zone des commentaires . Permet d'afficher des commentaires en rapport avec la
diaporama courante.

Zone de collaboration : Permet d'ajouter ou de visualiser des commentaires ou encore
de partager le document avec d'autres personnes.

Mo B ge bou s P Bl O VAR RS —
‘o BN GG S W asmesin | e | i -, . ——ee
! — . | Barre des menus | Zone dg

Barre d'outils ] . collaboration |

Zone de
Ej‘;ﬁ?‘;&“ﬁ Cliquez ici pour ajouter
un titre

Cliguez ici pour ajouter un sous-titre

Zone des
commentaires
L "
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Manipulation et notion de base

Creer une présentation | B3 Dossier

Pour créer une nouvelle présentation, cliquez sur “Nouveau”, puis importer un fichier
Google Slides pour lancez la creéation. Importer un dossier
Pour donner un nom a votre présentation, cliquez sur Présentation | B coogenocs
sans titre. Vous pouvez ensuite la renommer a tout moment en Google Sheets

cliquant a nouveau sur le titre. |

| Google Slides

. 1 L= s e — s 1

Convertir des fichiers PowerPoint (Office) en Google Slides

Pour utiliser des fichiers PowerPoint concu avec des applications différentes comme la suite
Office et pouvoir les éditer de Google Slides , vous devez les convertir. Voici la marche a

suivre ;

1. Transférer vos documents sur le Drive. Nouveau > Importer un fichier.

2. Une fois le fichier transféré, double-cliquez dessus pour L'ouvrir.

3. Puis faite Fichier > Enregistrer au format Google Slides.

Attention : La plupart des document PowerPoint basique peuvent étre convertis sans aucun
probleme vers Google Slides. Cependant, des fichiers complexes avec des effets ou de
grandes tailles peuvent ne pas étre converti correctement. Vérifier bien vos fichiers apres

conversion !
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Appliquer un modele préedéfinis

Suite a la création d'une nouvelle présentation, vous étes invité a choisir un théme, afin de
définir un arriére-plan et des polices identiques sur l'ensemble de vos diapositives.

Vous donnez ainsi plus de style et une apparence cohérente a votre présentation. Toutefois,
si vous le souhaitez, vous pouvez modifier le fond d'écran et les polices pour une diapositive
donnée.

Vous avez également la possibilité de définir un autre theme par la suite si vous changez
d'avis.

Choisir un theme

DE GOOGLE

Clair simple Sombre simple Dégradé clair Dégradé sombre

Suisse

Moderne

I | B 2 I

Importer un théme Taille de la diapositive : = Grand écran (16:9) %

“ Annuler +/ Afficher pour les nouvelles présentations

Bonus : si les slides proposés depuis la sélection ne vous conviennent pas totalement, je
vous conseille d'aller jeter un coup d'oeil sur le site “Slide Carnival”. Je ne doute pas que
vous trouverez votre bonheur sur ce site qui propose des templates d'une grande qualite.

‘Camivai

Farmal Inspiratianal Creativa Simple Startup Elagant Playful Business a

FREE PRESENTATION TEMPLATES

Find free guality presentaticn templates and focus on communicating your ideas. These designs cover all styles from playful and creative to formal and
business presentations, and all templates are easy-to-edit. Use them freely for wour own presentation needs, work right away in Google Slides or download

the templates as a PowerPoint file and continue working on your computer.

o © B AT

E THIS IS YOUR This is vour

PRESENTATION , Sl
T e . presentation title
L S {
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Mise en forme d'un document Slide

Modifier votre préesentation

Pour personnaliser votre présentation, utilisez la barre d'outils et de menu.

Fichier Edition Affichage Inserion DOiapositive Formal Réorganser COuilis  Tableau  Akde Toutes les modifications enrfegisirdes dans Dvive

-""""'r" a KR MGE-N- 8-2.-=.5- A e -[B|7f U A-B-lcoH E- - EE@@ L

Information: Si vous n'étes pas en train de modifier du texte, tous les eléments illustrés ici
ne figurent pas dans la barre d'outils. Pour activer les options liées au texte, sélectionnez
une zone de texte dans votre présentation.

Modifier les masques de diapositive

Lors de la création d'une présentation, vous pouvez choisir plusieurs themes et mises en
page. Il vous est également possible de modifier ces themes et mises en page, afin d'utiliser
des styles personnalises.

Vous pouvez ainsi modifier la diapositive maitre et les mises en page individuelles.

La diapositive Maitre

Cette diapositive qui est associé a un theme a une utilité double. les paramétres qui s'y
trouvent contiennent les styles de texte par défaut utilises dans la présentation. L'arriere-plan
et tous les autres forme présentes constituent larriere-plan par défaut de 'ensemble des
diapositives.

Pour qu'une image/logo apparaisse sur chaque diapositive de votre présentation, vous devez
modifier la diapositive maitre.

Mises en page individuelles

Les modeles de mise en page déterminent la facon dont le contenu est disposé sur chaque
type de diapositive. Ainsi, si vous souhaitez que toutes vos diapositives de titres aient une
disposition spécifique, il vous faudra modifier le modéle de mise en page de titre.
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Modification d'un theme

Pour modifier et appliquer un theme préetabli, il vous suffit de cliquez sur le bouton ,
ou encre depuis la barre de menu Diapositive > Changer de théme...

Pour personnaliser complétement un théeme déja existant, il faut pour cela modifier les
modéles maitre et mises en page. procédez alors comme ci-dessous :

1.

2.

Cliquez sur le menu Diapositive > Modifier le masque.
Vous aurez alors accés a l'éditeur de modele maitre.

Pour modifier le maitre ou l'une des mises en pages, sélectionnez la diapositive
correspondante dans la liste de gauche, puis appliquez les modifications.

Lors de la modification du modéle maitre et des mises en page, vous pouvez
egalement effectuer les actions suivantes :

o Insérer une nouvelle mise en page personnalisée

o Dupliquer une mise en page

o Supprimer une mise en page

o Insérer un espace réserve (Insertion > Espace réserve)

Vos modifications seront automatiquement enregistrees. Pour quitter l'éditeur, cliquez
sur la croix “X" an haut a droite de la fenétre.

e Premier niveau
o Deuxiéme niveau

m Troisiéme niveau
e Quatrieme niveau
o Cinquieme niveau
m Sixieme niveau
e Septiéme niveau
o Huitiéme niveau
m Neuviéme niveau

Les diverses modifications que vous aurez effectuées dans le modéle de masque vont
impacter l'ensemble des diapositives existantes de votre présentation, ainsi que toutes les
nouvelles diapositives que vous ajouterez.

397125



Insertion, duplication et suppression

Pour insérer, dupliquer ou encore supprimer une diapositive, il vous suffit de cliquez sur le
bouton “Diapositive” dans la barre de menu, ou encore de faire un clic-droit sur une
diapositive et ensuite de sélectionner l'un des options souhaitée.

Organiser et numéroter les diapositives

Reéorganiser les diapositives

Pour modifiez l'ordre des diapositives, il vous suffit de sélectionner une diapositive et ensuite
de la faire glisser avec votre souris a l'endroit souhaite.

Information : Pour sélectionner plusieurs diapositives a la fois, placez vous sur la premiere
diapositive appuyez sur la touche maj puis cliquez avec votre souris sur la derniere
diapositive de la série. Pour sélectionner plusieurs diapositives non consécutive,
maintenez la touche Ctrl enfoncée, puis cliquez sur les diapositives a déplacer.

Numeération des diapositives

Pour numeéroter les diapositives d'une présentation, il vous Numéros des diapositives...
suffit de cliquez sur le menu Insertion > Numéros de {b
diapositives...

R . . i ) Numéros de diapositives
Il ne vous reste alors qu'a choisir entre activer ou désactiver

la fonctionnalité, et dans la positive de choisir d'ignorer ou s Activé Désactive

non les diapositives de titre. S :
Ignorer les diapositives de titre

Mettre en forme du texte iz ik oo

Modifier la police

Pour modifier la police dans un cadre de texte de votre présentation Google Slides, il vous
suffit de sélectionner votre texte puis de cliquez sur le bouton sélecteur de police

Arial b4

défaub).

presente dans la barre d'outils afin de choisir une police différente (Arial par

Modifier la couleur

Pour modifier la couleur de texte ou de surbrillance dans une section spécifique, il vous suffit

de sélectionner le texte souhaité et de cliquez sur le bouton dans la barre d'outils et de
sélectionnez “texte” ou “Arriére-plan” et enfin de choisir une couleur.
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Modifier la taille de vos diapositives

Pour modifier la taille des diapositives, cliquez sur Menu > Configuration de la page.

Sélectionnez alors lune des tailles proposées dans la liste »
déroulante. Vous pouvez également specifiez une dimensions Configuration de la page

personnalisée avec la champ “personnalisée”.

Grand écran (16:9) &

Mettre en forme les listes a puces / listes numérotéees

Pour insérer des listes a puces ou des listes numérotées dans la zone de texte d'un

preésentation, cliquez sur le bouton

-

ou

-

selon le type de liste souhaite. Pour choisir

un style de liste différent pour les liste a puces ou numeérotées, cliquez sur la fleche pour

obtenir plus de possibilites.

Personnaliser une liste puces/numeérote

Pour modifier les puces et les numéros d'une liste, que ce soit de maniére individuelle ou
groupeée. Tout d'abord, cliquez sur lune d'entre elles pour selectionner lensemble des puces
d'une liste, ou double-cliquez sur une puce pour ne sélectionner que cette derniere.

Modifier le type des puces : Pour modifier le type d'une ou d'un ees—yrvrv

ensemble de puce, sélectionnez lalles) puce(s), puis faites un

clic-droit.

Modifier la couleur des puces :

la(des) puce(s), cliquez sur licone dans la barre d'outils et

choisissez une couleur.

Pour changer la couleur de

Plus de puces...

Mettre a jour dans le théme
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Insérer des élements

Insérer un lien

Pour ajouter un ou des lien(s) dans Google Documents, il vous suffit de procédez comme suit :

Sélectionnez le contenu (texte, image, etc) auquel vous souhaitez associer un lien. Cliquez
sur licéne de lien [®2ldans la barre d'outils ou clic-droit > lien ou Ctrl+K. Saisissez

maintenant 'URL, puis cliquez sur Appliquer.

d'un lien de test.

Texte lien

Lien ‘ Coller un lien ou effectuer une recherche

Lien - Wikipedia, the free encycl...
= https:Jen wikipedia. org/wikilLien

wrm | ien Nofinitinn | Invactnnadia

Information : Vous pouvez par lintermediaire d'un lien faire référence a differents types de
contenu comme une page web, une document (Docs, Sheets, Slides, etc..) ou encore un

chapitre de votre document.
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Insérer des images

Si vous souhaitez insérer une image et la mettre en forme dans votre document, proceder
comme suit :

Cliquez sur Insertion > Image > Sélectionnez ensuite une image. Vous pouvez importer une
image depuis votre ordinateur, en sélectionner une dans Google Drive ou vos albums photo,
en rechercher une photo sur Internet ou prendre un instantané.

Une fois limage ajoutée, vous pouvez la supprimer ou la m

redimensionner a tout moment.

c —
Pour supprimer une image, se¢lectionnez la, faites un clic-droit | ‘
(ou cliquez sur Edition), puis choisissez Couper ou cliquez sur la a—
touche Suppr.

Pour redimensionner une image, cliquez dessus, puis faites
glisser l'une des poignees de selection. Utilisez les poignees d'angle pour redimensionner
une image tout en en conservant les proportions. Utilisez les poignées du haut, du bas ou
latérales pour modifier une seule dimension.

Vous pouvez enfin intégrer votre image de différentes facon dans le document (Aligner,
Envelopper, Intercaler).
Ajouter une bordures a une image

Pour ajouter une bordure a une image, cliquez sur celle-ci est utilisez les options disponibles
depuis la barre d’'outils. Dans ce cas, il ne suffit que de sélectionner une couleur et une taille
de bordure.

S -=-=- 'E[. ﬂ Options de I'image...  Remplacer I'image...
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Insertion d'autres contenu

Vous pouvez egalement insérer d'autres types de contenu dans votre document Google

Docs.

Voici la liste des eléements qu'il vous est possible d'insérer depuis le menu Insertion present
dans la barre d'outils :

Zone de texte.

Image.

Lien : gjouter un lien a un élément.
Vidéo : intégrer une video.

Word Art : texte avec effet.

Trait : integre différent type de trait comme des fléches,
connecteurs..

Forme : integre des dessins prée-enregistre (Forme, Legende,
fleche, equation).

Tableau : ‘développé plus bas dans le document..
Numeéros de diapositives.
Commentaires.

Caracteéres spéciaux.

Zone de texte

[aa] Image...

By Vidéo...

B Word Art

™, Trait -

(i Forme -
Tableau "

Numéros des diapositives. ..

B Commentaire Ctrl+Alt+M

Nouvelle diapositive Ctrl+M

Importer des diapositives. ..
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Tableau et encadrements

Nous allons voir dans cette partie les difféerentes notions autour des tableaux et des
encadrements sur Google Slides.

Ajouter un tableau

Les tableaux constituent un excellent moyen d'organiser les informations de votre document.
Pour insérer un tableau dans votre document, procédez comme suit :

1. Cliquez sur Tableau > Insérer un tableau. | Tableau = Modules complémentaires  Aide T

| Insérer un tableau - ]

2. Indiquer le nombre de lignes et de colonnes |
souhaitees. i

Ensuite, procédez a la mise en forme du tableau et il ne vous =N : ot
reste alors qu'a renseigner les différentes cases. i e ——

Information : Pour colorer les cellules, sélectionnez le texte d'une ou plusieurs cellules,

cliquez sur Tableau > Propriétés du tableau (ou avec l'icéne ). puis definissez la couleur
d'arriere-plan des cellules.

Exemple, tableau avec un fond vert :
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Fusionner les cellules d'un tableau

Pour fusionner les cellules d'un tableau dans votre document Google Docs, il vous suffit de
sélectionner les cellules a fusionner et de faire un clic-droit et de sélectionner “Fusionner
les cellules”.

Pour annuler la fusion, sélectionner les cellules concernées, puis clic-droit et “Défusionner
les cellules™.

Fusionner les cellules

Ajouter au théme =

Redimensionner un tableau

Pour redimensionner un tableau, il vous suffit d'utiliser le sélecteur en placant votre souris
sur l'une des lignes ou colonnes de votre tableau. Rester ensuite cliquez avec le clic gauche
de votre souris et déplacer la lighe ou la colonne comme bon vous semble.

Définir le style des cellules

Vous pouvez également définir un style spécifique aux difféerentes
bordures et cellules de votre tableau.

o-F-=-=-

Pour modifier les contours d'une cellules, placez votre sélecteur dans celle-ci puis modifier
la mise en forme avec les icones de tableau présentes dans la barre d'outils.
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Les differents mode d'affichage

Lecture et prévisualisation

uE_ire B Commentaires
Lorsque vous étes prét a prévisualiser ou a lire les Lire depuis le début Ctri+Maj+F5
diapositives, cliquez sur le bouton Lire en haut a droite e o ks s i i
de la page. Lire dans une nouvelle fenétre

Pour afficher d'autres options, cliquez sur la fléeche vers le bas.

& Diapositive 3 = | 35 I3 Quitter

Si vous déplacez la souris pendant la lecture du diaporama, une barre de commandes
s'affiche temporairement.

Elle permet de passer a une autre diapositive, d'interrompre ou de reprendre la lecture du
diaporama, ainsi que d'activer et de désactiver le mode plein écran.

Ouvrir les commentaires du présentateur ‘b
Imprimer
Télécharger au format PDF

Télécharger au format PPTX

| Quitter

Pour afficher d'autres options, cliquez sur l'icone représentant une roue dentée.

- Diapositive: Diapositive a
partir de la droite

Diapositive a partir de la droite-

Lente Intermediaire Rapide

Appliquer & toutes les diapositives
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Transition entres les diaporamas

Afin de rendre votre présentation plus conviviale, vous avez la possibilité de choisir une
animation spécifique lors de la lecture de vos diaporamas. Vous avez notamment le choix
entre les animations suivantes :

- Aucune transition

- Fondu

- Diapositive a partir de la droite

- Diapositive a partir de la gauche
- Retourner

- Cube

- Galerie

Apres avoir choisi une animation, vous pouvez définir la vitesse de transition (lente,
intermeédiaire, rapide) ou encore choisir d'appliquer les modifications a toutes les diaporamas
ou non.
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Mise en page et impression

Pour imprimer des diapositives et choisir la mise en page, cliquez sur Fichier > Paramétres

d’impression et apercu.

Une nouvelle fenétre va alors s'afficher avec l'apercu de limpression des diapositives sur les

feuilles.

Depuis cette fenétre, vous allez pouvoir choisir :
- Le nombre de diapositive a afficher
- Masquer ou non l'arriére plan
- Télécharger le document en PDF

- Imprimer le document

« Fermer I'apergu 1 diapositive avec des notes - it Masquer I'arriére-plan
1 diapositive sans note

v 1 diapositive avec des notes

Docume‘@ Une diapositive par page

Télécharger au format PDF

Document -
Document -
Document -

Document -

Deux diapositives par page
Trois diapositives par page
Quatre diapositives par page

Six diapositives par page

Document - Neuf diapositives par page

Une fois que vous avez choisi les parametres adéquate, cliquer sur Imprimer pour accéder a

la fenétre d'impression.

Il ne vous reste plus qu'a choisir vos paramétres d'impression (copie d'ecran ci-contre).

. r= m (=T |
Destination e
| Modifier... |
Pages ® Tous
Copies 1 | +
Taille du
papier ad
Options | Ajuster & la page
¥ Recto verso
Imprimer via la boite de dialegue du systéme..
(Ctrl+Shift+P)
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Te[echargement Microsoft PowerPoint (pptx)

Vous pouvez également télécharger le fichier en différent format, 1L | 2°eme™ FoF (p<D

vous suffit pour cela de faire Fichier > Télécharger au format et de
seélectionner le format souhaite.

Scalable Vector Graphics (.svg)
Image PNG (.png)
Image JPEG (jpg)

Texte brut (.txt)

Trucs et astuces : En savoir plus

Vous connaissez désormais les bases de la création d'une présentation Google Slides. Vous
souhaitez aller plus loin dans lutilisation de l'application ? Voici dans ce chapitre quelques
trucs & astuces pour pourraient bien cous étre utile.

Cacher un slide

La fonction cacher/masquer n'est actuellement pas disponible dans Google Slides.
Cependant, il existe une méthode pour contourner ce probleme en attendant l'arrivée de
cette evolution.

La méthode va étre de placer les diaporamas a cacher a la fin du document et d'y accéder
par l'intermédiaire de lien.

1. Déplacez les diaporamas a cacher a la fin du document.

2. Placez un premier lien de re-direction (zone de texte ou image) sur le slide précedent
le slide a masquer.

3. Puis sur le slide caché ajoutez un lien de retour vers le slide suivant.

4. Lors du lancement du diaporama il ne vous restera qu'a cliquer sur les différents liens.
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Publier un Google slide sur le Web

Depuis Google Slides, vous pouvez publier simplement une presentation sur internet. Pour ce
faire, cliquez sur Fichier > Publier sur le Web...

Depuis la fenétre qui va s'afficher, vous allez pouvoir de :

Le délai d’avancement des diapositives.
La taille de la présentation (en cliquant sur l'onglet Intégrer).
Démarrer la présentation dés que le lecteur est chargé.

Redémarrer le diaporama a la fin de la présentation.

Ce document n'est pas publié sur Internet.

Rendez votre contenu visible par tous en le publiant sur le Web. Vous pouvez créer
un lien vers votre document ou lintégrer & un site Web. En savoir plus

Intégrer

Faire avancer
automatiquement les
Taille de la présentation : diapositives :

Moyenne (360x569) - toutes les 3 secondes (pa &

Démarrer le diaporama dés que le lecteur est chargé

Redémarrer le diaporama aprés |a demiére diapositive

Publier

Apres avoir défini les parametres, il ne vous reste qu'a cliquez sur Publier pour obtenir une
URL pour visualiser la présentation sur le Web.
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Ajouter des polices a la liste de polices

Si la langue paramétree correspond a l'une des langues suivantes :

h An g Lals Q Afficher : Toutes les polices =  Trier : Popularité ~ Mes polices
- A“.emaﬂd Calibri
- Catalan f O can
- Danois Roboto Conselss
- Néerlandais Lato
- Finnois Oswald Drold Serif
- Fran(;als Roboto Condensed Open Sans
- |ta|.|eﬂ liEa s¥ncoraTe
- Norvegien
) Source Sans Pro
- Portugais
Pour ajouter des polices a la liste, il vous suffit d'ouvrir le
sélecteur de police et de cliquer sur Autres polices. F+  Autres polices. .. '{b
Vous pourrez alors choisir et integrer un plus grand nombre o 1l

de police a la liste.
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Ajouter des commentaires d'intervenant

Utilisez les commentaires d'intervenant afin de noter
les points clés a aborder pour chaque diapositive.
Dans l'éditeur de présentation, les commentaires
apparaissent dans la zone de texte affichée sous la
diapositive actuelle. Cette zone contient le texte
Cliquez ici pour ajouter des notes lorsque vous
ajoutez une nouvelle diapositive.

Si vous ne voyez aucun commentaire, cliquez sur le
menu Affichage et assurez vous que l'option Afficher
les commentaires du présentateur est activee.

Lors de la lecture du diaporama, les commentaires
de lintervenant s'affichent dans une fenétre

I Animations

Affichage | Insertion

<

X

Diapositive Fomnat Réorganiser Outlls Tableau Aide  Toutes les modifications envegistrées dans Drive
Lire. Ci+F5 | Amiére-plan.. Miseenpage - Théme.. Transition...
Cti+Alts Maj+8

Masque

50%

100%
200%

Cui+Alts+

- Zliquez ici pour ajouter du

Cirt+AltsMaj¢H

Zoom avant

Zoom aiére
Aligner sur
Affichage HTML
Afficher les suggestions orthographiques
Afficher les commentaires du présentateur

Mode Compact Ctri+Maj+F

Cliquez ci pour ajouter des commentaires

separee, qui contient egalement des commandes permettant d'avancer dans les diapositives

ou d'interrompre la lecture.
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==

Google Sheets : Tableur

Environnement de Google Sheets

Google Sheets est un tableur qui utilise une ergonomie la plus visible et simple possible. Elle
est donc composée d'une zone de menu avec les différents onglets (Fichier, Edition,
Affichage, etc.), d'une barre d'outils avec les options de mise en page et les fonctions
basiques et les plus utiles.

La difference par rapport avec un tableur traditionnel se situe cependant au niveau du
partage et de la collaboration avec les boutons “‘commentaires’ et “partager”.

Nous allons voir en détails les differentes manipulations possibles et les fonctionnalités que
propose la solution de tableur de Google.
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Composition d'un document Google Sheets

Un document Sheets ressemble beaucoup a la plupart des tableurs présent depuis plus
longtemps sur le marché comme le fameux Excel de Microsoft,

Voici un tour d'horizon d'une page vierge de l'application.

Barre des menus : Toutes les commandes sont disponibles depuis ce menu.
Barre d'outils : Permet de lancer des commandes avec un simple bouton.
Barre de formule : Affiche le contenu de la cellule active.

Onglet(s) de feuille : Choix de la feuille affiche a l'écran.

Zone de collaboration : Permet d'ajouter ou de visualiser des commentaires ou encore

de partager le document avec d'autres personnes.

Shests de test ]
Fichier Edition Affichage Inseion Format Données Outils  Modubes complémentabes - Alde Accesaibiits  Toules les modifications erregistioes dars [rive ~Commesisres m
S AP % oo 8B A o w - B I g A. ¥ - |

°l[ I“BEFTB.d-ES.mEIﬂIJS TEI L

L] H i ] L L

N . . c o E " |
Barre de formule Pl @ Zone de
collaboration

(Onglet(s) de feuille |

il
4+ @ Foule | &
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Manipulation et notion de base

Créer une feuille de calcul L sasier

Dans Google Drive, cliquez sur le bouton Nouveau, puis Google Sheets Importer un fichier
pour creer un nouveau classeur. o
Pour donner un nom a votre feuille de calcul, cliquez sur Feuille de B GoogleDocs

calcul sans titre. Google Shests

Vous pouvez ensuite la renommer a tout moment en cliquant sur le titre. [ Soagle Sl

Convertir des fichiers Excel en Sheets

Pour utiliser des fichiers tableur concu avec des applications difféerentes comme excel et
pouvoir les éditer de Google Sheets, vous devez les convertir. Voici la marche a suivre :

1. Transférer vos documents sur le Drive. Nouveau > Importer un fichier.

2. Une fois le fichier transfére, double-cliquez dessus
pour l'ouvrir.

Fichier Modifier Insérer Format Aide

Mode de compatibilité Office (@)

3. Puis faite Fichier > Enregistrer au format Google | i Enregistrer au fomat Google Shests
Sheets. : =

Attention : La plupart des document Excel basique peuvent étre convertis sans aucun
probléeme vers Google Sheets. Cependant, des fichiers complexes avec des macros ou de
grandes tailles peuvent ne pas étre converti correctement. Veérifier bien vos fichiers apres
conversion !

Déplacement dans une feuille

Outre la souris, Les fleches de direction de votre clavier permettent un déplacement de ligne
a ligne ou colonne a colonne. Vous pouvez aussi utiliser la barre de défilement droite et bas
(ascenseurs) selon le fichier.

Déplacement rapide dans une feuille

Pour vous déplacez rapidement d'un endroit a lautre d'une feuille de calcul, utilisez la
combinaison de touches ci-dessous, selon 'emplacement a rejoindre :

- "Ctrl"+ "Fléeche Haut"
- "Ctrl"+ "Fléche Bas"
- "Ctrl" + "Fleche droite"
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- "Ctrl" + "Fleche gauche’

Mettre en forme les données dans la feuille de calcul

Pour saisir du texte ou des données dans votre feuille de calcul, il vous suffit de cliquer dans
une cellule et de commencer la saisie. Par défaut, les données sont saisies au format
"Normal”. Aucune mise en forme particuliére n'est appliquée a ce que vous saisissez.

Pour formater les cellules sélectionnées dans votre feuille de calcul, utilisez les menus et la
barre d'outils.

Fichier Edition Affichage Insertion Format Données Outils  Modules complémentaires  Aide  Accessibilité  Demiére modification le 30 juin

+l |- coBMY-Z-

= g, - i - - L -
e AP o€ % o0 00123 Aal 10 B 7 5 A. *. 3

Mise en forme courantes

Voici une liste des principales actions qu'il est possible d'appliquer a une ou plusieurs cellules :

Modification du format (hombres, dates, devises)

Modification de la police et de taille

- Mise en forme des cellules (gras, italique, barré)

- Modification de la couleur du texte ou/ et de la couleur de couleur de remplissage
- Ajout de bordure avec choix de la couleur et du style

- Fusion de cellules

- Alignement du texte (horizontal, vertical)

- Retour a la ligne (laisser dépasser, retour automatique, tronquer)

Mise en forme de cellules non adjacentes

Outre la mise en forme courante, les actions suivantes peuvent étre effectuées sur des
cellules non adjacentes :

- Suppression de valeurs

- Actions (Annuler, Répéter)

- Collage de valeurs (dans les cellules sélectionnées)
- Calcul d'une somme rapide

- Utilisation dans des formules et graphiques
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Sauts de ligne dans une cellule

Pour ajouter un saut de ligne a une cellule, placez le curseur dans une

cellule et utilisez la combinaison de touche Ctrl+*Entrée.

Format des cellules

Pour modifier le format d'une ou de plusieurs cellules, depuis la barre

d'outils, cliquez sur le bouton . Vous pouvez alors appliquer
différents formats a vos données. Tels que Devise, Pourcentage, Date,
Heure, Texte brut (les nombres sont traites comme du texte et non
comme des valeurs numeriques a interpreter).

Il est également possible de créer d'autres formats spécifique avec
Autres formats > Format de nombre personnalisé...

Taille des cellules

Pour modifier la taille (hauteur, largeur) d'une ou de plusieurs
cellules, sélectionner avec votre souris la colonnes ou la ligne
correspondant aux cellules concernées.

Faite alors un clic-droit > Redimensionner la(les)
ligne(s)/colonne(s)...

Vous devrez alors spécifier dans une nouvelle fenétre la valeur
souhaitee.

Redimensionner les lignes 14 - 17

Saisissez la nouvelle hauteur de ligne en pixels (valeur par défaut : 21).
21 |

saut de ligne

v Automatique

Texte brut
MNombre 100012
Pourcentage 10,12%
Scientifique 1.01E+03
Finances (1 000,12)
Devize 100012 €

16 | |

17 Couper

Ui Copier

12
Coller

20
2

23
24
25
26
27
28
29

an

Effectuer un collage spécial

Insérer 4 au-dessus

Insérer 4 au-dessous
Supprimer les lignes 16 - 19
Effacer les lignes 16 - 19
Masquer les lignes 16 - 19

Redimensionner les lignes 16 - 19.. R”"]
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Sélection de cellules

Pour sélectionner une cellule, il suffit de se placer dessus. Pour sélectionner plusieurs
cellules il faut distinguer deux cas bien distinct :

- Les cellules sont cotes a cotes . On dira qu'elles sont “adjacentes”.
- Les cellules sont éparpillées dans la feuille. On dira qu'elles sont “non-adjacentes”.

Sélectionner des cellules adjacentes

Avec la souris : Passez sur les cellules a formater en partant du point gauche supérieur et
déplacer la souris en tenant le bouton gauche appuyeé jusqu'a la cellule droite inférieure.

Avec le clavier : Placez vous sur la 1ere cellule (en haut a | |
gauche de la sélection) puis enfoncez la touche “Shift" (Fleche
au-dessus de CTRL). En maintenant cette touche enfoncee,
agrandissez la sélection avec les fleches de direction.

"A utiliser si vous avez beaucoup de lignes ou de colonnes a
sélectionner car la souris est parfois trop rapide.

Information : Vous pouvez également sélectionner toutes les cases d'une ligne ou d'une
colonne avec la combinaison “Shift” + “Ctrl” + “Fleche”.

Sélectionner des cellules non-adjacentes A
L. . Ly . 1 |NORD
Pour mettre en evidence des cellules non-adjacentes, utilisez la souris en | sk
cliguant sur les cellules a sélectionner une a une en maintenant la touche | s Eest
Ctrl enfoncee. “ B OUEST
.
Sélection diverses
A B c
Sélectionner toute la feuille : = oo B T TRIM2 mj
2 CENTRE 130 135
. s . NORD 120 130
Un clic dans le carré a droite du A et en Haut du 1 permet de B a0 147
~ H 5| EST 132 135
selectionner toute les cases. . o o e
Sélectionner des lignes (ou colonnes) :
. ’ . ~ . . . . A B C
Cliquez sur le numeéro de la ligne a sélectionner (partie grise). \ Recions | TR TR,J
A . . , . . . . 2 | CENTRE 130
Si il 'y en a plusieurs a selectionner etendez la selectionnez de | ;miarp o
la méme facon que pour les cellules adjacentes (étendre la | + sup 140
sélection vers le haut ou le bas) ou non-adjacentes (par clic + | & EST 132
ctrl). “idem pour les colonnes. S EAT s
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Fusionner des cellules

Pour fusionner plusieurs cellules en une seule, il vous suffit de sélectionner les cellules a

fusionner et de cliquer sur le bouton depuis la barre d'outils.

En cliquant sur la petite fleche a droite du bouton de fusion, vous avez également la
possibilité de choisir d'autres proposition :

Tout fusionner S -4 -|+- e F
. . Tout fusionner
Fusionner horizontalement

Fusionner horizonfyement

Fusionner verticalement Fusionner verticalement

Annuler la fusion

Annuler la fusion

Pour annuler une fusion, sélectionner la cellule et appuyer sur le bouton fusion (ou annuler la
fusion avec la petite fleche).

Liste déroulante dans une cellule

Il est possible de creer des listes déroulantes dans des cellules individuelles a l'aide de l'outil
de validation des données. Vous pouvez soit créer une liste par rapport a une plage de
cellules ou depuis une liste personnalisées.

Validation d'une plage

1

o o~ W

Saisir des données dans une plage de cellules.

Sélectionner la cellule a valider.

Dans la barre de menu Données > Validation...

Dans “Critéres”, sélectionnez “Liste créée a partir d'une plage”.
Spécifiez la plage créer en 1.

Cliquez pour terminer sur Enregistrer pour valider les paramétres.
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Voiture

| Moto
Camion
Avion

Bateau

L= = = B I e

|

Voiture
Moto
Camion
Avion

Bateau
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Liste personnalisée

1.

o o~ W

Saisir des données dans une plage de cellules.
Sélectionner la cellule a valider.

Dans la barre de menu > Données > Validation...
Sélectionnez la case “Saisir les éléments de liste”.

Saisissez alors des valeurs separées avec une virgule.

Cliquez sur Enregistrer pour visualiser votre liste deroulante personnalisee.

Critéres : Liste d'éléments % | Voiture, Moto, Camion, Avion, Bateau /‘
En cas de données incomectes - (@ Afficher un avertissement Refuser la saisie
Apparence 7 Afficher une liste déroulante dans la cellule

Afficher laide en ligne :  Cliquez ici et saisissez une des valeurs de la list

‘Supprimer |a validation Annuler
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Les series automatiques
Google sheets peut eégalement saisir a votre place une suite logique de données.

Par exemple : Entrez 1 et 2 dans des cellules adjacentes.

Sélectionnez la plage des 2 cellules et cliquez ensuite sur le petit carré en bas a droite de la
selection.

Etendez la sélection vers le bas de quelques lignes. Vous voyez au fur et &8 mesure ce qui sera
inscrit dans les cellules.

Lachez la souris. la série est automatiquement saisie.

.|f.ﬂ|-h- [

Cela fonctionne aussi en ligne et sur d'autres types de séries :

1 Janvier 2014
2 fevrier 2015
3 mars 2016
4 avril 2007
5 mai 20§18
6 juin 2019
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Utiliser les lignes, les colonnes et les feuilles

La structure d'une feuille de calcul se compose de lignes et de colonnes de cellules
remplies de données. Chaque grille de lignes et de colonnes forme une feduille individuelle.

Ajouter une ligne ou une colonne Insertion Format Données
1. Sélectionnez n'importe quelle cellule devant se trouver a cote de Ligne au-dessus
la nouvelle ligne ou colonne. Ligne au-dessous
2. Dans la barre de menus, cliquez sur Insertion, puis ajouter une Colonne & gauche
lighe ou une colonne. Colonne & droite

Information : Pour ajouter plusieurs lignes ou colonnes a la fois, commencez par
sélectionner autant de lignes ou de colonnes que vous voulez en insérer.

Le menu “Insertion" vous permet alors d'ajouter ce méme nombre de lignes ou de
colonnes.

Par exemple, si vous sélectionnez un bloc de deux colonnes sur trois lignes, le menu
Insertion propose les options suivantes :

Insertion | Format Données Outils Aide Toutes les modifi

Ligne au-dessus

we A -R.H-
—
Ligne au-dessous

3 lignes au-dessus D
3 lignes au-dessous Due Date
Colonne a gauche | 47612012
Colonne a droite
4/9/2012
2 colonnes & gauche
team 412072012

2 colonnes a droite {b

aul 5/15/2012
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Supprimer une ligne ou une colonne

1. Sélectionnez une ou plusieurs cellules dans la ligne ou la
colonne que vous voulez supprimer. Si vous sélectionnez
plusieurs cellules, vous pouvez supprimer plusieurs lignes ou
colonnes a la fois.

2. Dans la barre de menus, cliquez sur “Edition”, puis choisissez
les lignes ou colonnes a supprimer. Par exemple, si vous
seélectionnez les lignes 4, 5 et 6 de la colonne C, vous pourrez
notamment :

- Supprimer les valeurs
- Supprimer les lignes selectionnees

- Supprimer totalement la colonne

Edition Affichage Insertion

v~ Annuler

~u Rétablir

x Couper
] Copier
[Tj Coller

Effectuer un collage spécial
Rechercher et remplacer...

Supprimer les valeurs
Supprimer les lignes 4 - 6

Supprimer la colonne C

Effacer les remarques

Format

Ctrl+Z
Ctri+Y

Ctrl+X
Ctri+C
Ctri+V

Ctrl+H

Information : Si vous souhaitez uniquement supprimer les données des cellules (tout en

conservant les lignes et les colonnes existantes), sélectionnez Supprimer les valeurs.
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Déplacer une ligne ou une colonne

Pour déplacer des cellules, vous pouvez utiliser les fonctions Copier et Coller (dans le menu
Edition ou dans le menu contextuel accessible avec un clic droit). Il existe toutefois une
solution plus rapide :

1.

Sélectionnez la cellule ou le bloc de cellules que vous
voulez déeplacer.

Placez votre curseur sur le bord des cellules
sélectionnées de sorte qu'il prenne la forme d'une main.

Maintenez alors le bouton de la souris enfoncé et faites
glisser les cellules jusqu'a leur nouvel emplacement.

Relachez le bouton de la souris pour déposer les cellules
a l'endroit voulu.

Figer les lignes et les colonnes d'en-téte

1 5590 37 33% |
2 $304.13 17%
3 5268 35 15%
‘ $143.12 8%
s $35.78 2% |
s $447.25| 25% |
7

s s 0%
8

"

L $590.37

A [

1 $590.37 3%

2 $304.13 7%

3 o835 o e |
i $143.12¢ 8%

5 $35.78| 2%

& $447.25) 25%

- .

B §LTES00 100%

9 |

10 I i

1

12

37 I . —

Les premiéres lignes ou colonnes peuvent étre des en-tétes que vous voulez garder visibles
en haut ou a gauche de votre feuille de calcul lorsque vous la parcourez. Dans ce cas, vous
pouvez figer les premieres lignes et colonnes afin de les garder affichées en permanence.
Vous pouvez ainsi figer jusqu'a dix lignes et cing colonnes.

pour figer une ligne/colonne, il vous suffit de cliquer sur Affichage > Figer les lignes ou
Affichage > Figer les colonnes, puis de selectionner le nombre de lignes ou de colonnes a

figer.

Dans l'exemple ci-contre, les deux lignes supérieures sont figées. Le trait plus épais sous la
ligne 2 l'indique.

A B c D E

1 Area * Milestone Owner Due Date Status
2
3 Send tiering proposal

Support policy to management Julian 4/6/2012 Complete
4 Assign specialists for

Support each area Alyssa 4/9/2012 Complete
5 Help content final

Documentation review Vandana 412012012 In progress
&

Training Finalize curriculum  Shiane and Paul §15/2012 Not started
T Estimate support

Support impact Sharon 41372012 Complete

Notes

Approved

Need to identify
additional trainer

Information : Vous pouvez également “glisser-deposer” les lignes bleues pour modifier

rapidement le nombre de lignes ou de colonnes figeées.
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Une fois figée, la ligne d'en-téte reste alors visible lorsque vous parcourez votre feuille de

calcul.

Masquer des lignes ou des colonnes

Pour masquer des lignes ou des colonnes, selectionner les lalles) |
ligne(s) ou la(les) colonne(s) a masquer puis faites un clic-droit SUr | . srectuer un coliage spscial

celle-ci. Puis cliquer sur “masquer les lignes...”.

Trier des données

Dans le cas de donneées a trier, placez vous sur la premiere
cellule de donnée a trier puis faite Données, puis seélectionner
ensuite l'option qui correspond le mieux a votre cas :

- Trier la feuille a partir de la colonne..
- Trier la plage a partir de la colonne..

- Trier la plage..

11 Couper
Copier

Coller

47 Insérer 4 au-dessus

18 Insérer 4 au-dessous

Supprimer les lignes 10 - 13

Effacer les lignes 10- 13

22 Masquer les lignes 10 - 13 {tv)

Données  Outils  Modules complémentaires Al

Trier la feuille & partir de la colonne A, A — Z

Trier la feuille a partir de la colonne A, Z — A

Trier la plage a partir de la colonne A, A — Z

Trier la plage a partir de la colonne A, Z — A

Trier la plage...

Vous pouvez egalement trier un ensemble de donnees en selectionnant directement un
tableau. Pour cela, sélectionner votre tableau puis faite un clic-droit > Trier la plage...

Trier la plage A1 & E6
Données avec ligne d'en-téte

Trier par Colonne A &

+ Ajouter une colonne pour le tri

Vous pourrez ainsi trier la plage plus en détail. Notamment en Trier les données par colonnes

et en ajoutant des criteres de tris supplémentaires.

Effacer les remargues

Mise en forme conditionnelle. .. {b

Validation des données...
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Mise en forme conditionnelle

Pour mettre en place une ou des regles de mise en forme conditionnelle, il faut spéecifier une
cellule ou un ensemble de cellules, puis faire un clic-droit > Mise en forme conditionnelle...
ou encore depuis la barre de menu Format > Mise en forme conditionnelle.

Suite a la validation, vous allez avoir acces a une nouvelle fenétre sur le coté droit de votre
feuille. Depuis cette fenétre vous allez avoir la possibilité de définir vos critéres de condition,
comme par exemple en fonction :

Couleur unie Dégradé de couleur
- Du contenu (vide ou non)
Appliquer a la plage
- Dutexte A1EB =
- De la date (anterieure, posterieure) e —
.. . . . La cellule n'est pas vide -
- De la valeur (supérieure, inférieure, égal, ..) =
Style de mise en forme
- Ou encore choisir des conditions personnalisée s =

Ensuite, vous pouvez choisir une mise en forme spécifique pour la B ZSA. .
condition et si vous le souhaitez ajouter une nouvelle condition.
.:::. Annuler

Ajouter une régle b
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Ajouter une nouvelle feuille

Un projet donné peut comporter plusieurs feuilles de calcul. Par exemple, une agence de
voyages organisant un circuit peut avoir besoin de plusieurs feuilles de calcul pour les dates,
les clients, le transport, les hotels, les excursions et ainsi de suite.

Au lieu de créer plusieurs feuilles de calcul, vous pouvez ajouter des feuilles et passer de
l'une a l'autre dans une méme feuille de calcul, comme vous le feriez avec les onglets d'un
navigateur pour parcourir différents sites Web.

Pour ajouter une feuille :

1. Cliquez sur le signe plus (+) en bas a gauche de votre feuille de calcul.

19
20

Ajouter une feuille

+ = Feuille1~

2. Par defaut, les feuilles sont nommeées Feuille 1, Feuille 2, Feuille 3 et ainsi de suite, mais
vous pouvez les renommer.

Supprimer
Dupliguer

Copier dans...
Renommer {b
Protéger la feuille..

Masquer la feuille

Déplacer a gauche

jan  Hotels | Feuille 6 =

3. Sélectionnez l'onglet de la nouvelle feuille, cliquez sur la fleche déroulante, puis
cliguez sur Renommer.

Information : Pour changer rapidement lordre des feuilles, il vous suffit de faire un
‘glisser-deposer”.
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Gestion des feuilles

Vous avez deux possibilités pour créer une nouvelle feuille dans un fichier Sheets.

1

2. Depuis la barre d'onglet : Cliquez sur le bouton

Depuis le menu : Insertion > Nouvelle feuille.

[ + ".

Ajouter une feuille

| Feullie 1 ~ [}

+
1]

o

Le bouton [E] permet quant a lui de vérifier la feuille ou on se trouve et également de se
placer sur une autre feuille.

Avez un clic-droit sur l'onglet d'une feuille, vous avez accés a plusieurs options :

Supprimer : Supprime la feuille courante.

Dupliquer : Réalise une copie de la feuille selectionnée.
Copier dans... : Copier la feuille dans un autre fichier Sheets.
Renommer... : Renommer la feuille selectionnee.

Protéger la feuille.. : Permet de protéger la feuille dans sa totalité ou seulement
quelques cases.

Masquer la feuille : Cache la feuille de la liste des onglets. Pour la ré-afficher (Affichage
> Feuilles masqueés).

Déplacer : Deplacer a Gauche ou a Droite l'onglet dans le cas ou il y en aurait plusieurs.

Supprimer
Dupliquer

Copier dans...
Renommer...
Meodifier la couleur
Protéger la feuille. ..

Masquer la feuille

Déplacer a droite

Feuille 1 ~ | Graphique -
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Protéger une feuille ou une zone

Feuilles et plages protégées b4

Pour protéger une feuille ou une zone spécifique d'une fedille, il faut
faire un clic-droit sur la feuille en question puis Protéger la feuille.

Il ne vous reste alors qu'a spécifier la feuille ou la zone, de cliquer s Feutle
sur Définir les autorisations et de spécifier 'option qui vous convient |  Facture -
le plUS . Exclure certaines cellules

- Afficher un avertissement lorsque cette plage est modifiee.

Annuler

- Restreindre les utilisateurs a modifier cette plage

Récupération des données d'une feuille dans une autre

Pour repliquer des donnees d'une feuille a une autre, il faut renseigner le nom de la feuille et
la le champ spécifique.

Par exemple : pour copier la données (A1) d'un tableau de la feuille 1 dans la feuille 4, on
notera la formule suivante : =feuille1!A1

Attention : Dans le cas ou votre feuille contient des espaces ou d'autres symboles non
alphanumeériques, vous devrez la placez entre guillemets soit.

Dans notre exemple si la feuille 1 avait un espace : ='feuille 1'!'A1

A

REGIONS .l

Information : Si vous souhaitez répliquer un ensemble de cellules dans une autre feuille
(dans le cas d'un tableau par exemple), il vous suffit de faire un glisser en cliquant sur le
carré bleu.

A A
REGIONS a REGIONS
NORD

| CENTRE |
_________________ u
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Nommer une zone

Pour faciliter des calculs ou des recherches, vous pouvez étre amene a nommer un cellule ou
une plage de cellule.

1. Sélectionnez la plage a nommer.
Insérer un lien

2. Faite un clic-droit sur la zone.

Definir la plage nommee. .. '{t")

. Cliguer sur Définir la plage nommeée..
3 9 plag Protéger la plage. ..

4. Nommer ensuite la zone et valider avec OK.

Référence relative et absolue

Selon la tache que vous voulez réaliser avec Google Sheets, vous pouvez utiliser soit des
références relatives, c'est-a-dire des reférences relatives a la position de la formule, soit
des références absolues qui font toujours référence a des cellules situées au méme
emplacement.

Si la lettre et/ou le numeéro sont précédés d'un signe
dollar, par exemple $B%$2, la ligne et/ou la colonne —
possédent une référence absolue. Les références :VIDDHUPIIE'ME:FEISE)]
relatives s'adaptent automatiquement lorsque vous les ? =

copiez, ce qui n‘est pas le cas des reféerences absolues.

T x T = L ¢ ] x -
-
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Démarrer avec les fonctions

En savoir plus avec toutes les fonctions disponibles.

Les fonctions permettent d'effectuer facilement et automatiquement des calculs. Pour

acceder aux fonctions, cliquez sur le signe Sigma @dans la barre d'outils d'édition. Vous

pouvez egalement cliquer sur Insertion > Fonctions dans la barre de menus.

Vous aurez ainsi immeédiatement accés a certaines des formules les
plus courantes telles que "'SUM" (Somme) et "AVERAGE" (Moyenne).

Pour en savoir plus sur ces fonctions et pour découvrir les autres
formules disponibles, cliquez sur Plus de fonctions.

Pour utiliser les données d'autres cellules dans vos fonctions, |

designez les cellules par le numéro de colonne suivi du numero de
ligne (AB, C2, etc)).

S I -

SUM
AVERAGE
COUNT
MAX

MM

Plus de foncfions... {j
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Utilisation de la fonction SUM

L'exemple ci-dessous explique comment utiliser la fonction SUM pour additionner les
cellules situées plus haut :

1. Sélectionnez la cellule qui doit contenir la somme.
2. Cliquez sur le bouton de fonction (signe Sigma), puis sélectionnez SUM,

3. La fonction SUM est inseréee dans la cellule.

23
BT
132
54
=sump |

4. Selectionnez la plage de cellules que vous voulez additionner. La plage de cellules (D2
a D5 dans cet exemple) est ajoutée a la fonction SUM.

=SUM(D2:D5

5. Pour afficher le réesultat, appuyez sur la touche Entrée ou Tabulation.

23

132

296
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Autres fonctions de calcul de base (Min, Max, SI, ET)

- Trouver la valeur minimale dans la plage de données (B5D5) la formule est :
MIN(B5:D5)

- Trouver la valeur maximale dans la plage de données (B5D5) la formule est :
MAX(B5:D5)

Fonction Si simple

- IF(C5=J5;3;2) — SiC5=J5 alors 3 sinon 2
Fonction Si imbriqués :

- IF(C5=J5:3;SI(C5=K5;1;2)) — Si C5=J5 alors 3 sinon si C5=K5 alors 1 sinon 2
Fonction avec Siimbriques & Et :

- IF(C2=600;"A";IF(AND(C2>400;C2<600);"B";"C")) — Si C2=600 alors A Sinon si C2>400
et C2<600 alors B sinon C.

Fonctions avancées

Filtrer vos données

Les filtres ont comme objectif de vous aidez a consulter et analyser plus facilement les
données d'une feduille de calcul. Ils permettent ainsi de masquer provisoirement les données
dont vous n'avez pas besoin.
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Utilisation des Filtres

Avant l'activation du filtre, vous devez sélectionner avec votre souris les données a filtrer.
Voici ci-contre, un exemple avec un tableau.

REGIONS TRIM1 TRIM2 TRIM3 TRIM4
NORD 120 130 123 157
CENTRE 130 135 140 145
EST 132 135 136 133
SUD 140 147 150 149
OUEST 147 146 150 157

1. Pour activer/désactiver les filtres, il vous suffit alors de cliquer sur le bouton
présent dans la barre d'outils. (ou encore “Données > Filtrer”).

2. Les options de filtrage sont ensuite accessible en cliquant sur le bouton =1,

REGIONS =1 TrRm1 =l TrRM2 =
NORD Trierde A — 2

CENTRE
EST

Trierde Z — A

SuD » Filtrer par condition .
QUEST
= Filtrer par valeurs...
Tout sélectionner - Effacer 4

v CENTRE
v EST

v NORD
v OUEST
v SUD

Vous pourrez alors filtrer vos données par :

- Condition : choix dans une liste de condition ou vous avez la possibilité de créez votre
propre condition (Ex : Cellule vide ou non, valeur inférieure a un seuil, présence d'une
lettre ou expression, ..)

- Valeur : pour filtrer par valeur, décochez les différents points que vous souhaitez
masquer puis cliquer sur OK pour valider la sélection. Vous pouvez eégalement pour
aller plus vite utiliser les boutons “Tout sélectionner”, “Effacer”.

- Recherche : Vous pouvez également spécifier directement un terme dans le champ de

recherche.

Attention : Lorsque vous ajoutez un filtre, les données filtrées le sont pour toutes les
personnes qui accedent a la feuille de calcul.

Information: Pour éviter les écrasement de données, un seul filtre est autorise par feuille de
calcul. Pour utiliser plusieurs filtres, il faut passer par les vues filtrées (developpees
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ci-dessous).

Les vues filtrees

Les vues filtrées peuvent étre tres utile, notamment si vous avez beaucoup de données et
egalement si le fichier est partagé avec d'autre personnes. Voici les principaux cas pour
['utilisation des filtres :

- Pas de modification des données pour les autres utilisateurs.
- Partager des filtres spéecifiques avec d'autres personnes.
- Enregistrer un filtre pour le réutiliser ultérieurement.
Pour créer une vue filtrée, sélectionner vos données et procedez comme suit :

1. Cliquez sur la fleche a coté du bouton de filtre et sélectionner “Créer une vue filtrée”
ou dans la barre de menu (Données > Vues filtrées > Creer une vue filtrée).

ks -

Creer une vue filtrée

2. La feuille va alors s'afficher avec un contour noir. Spécifiez un Nom a votre filtre et
appliquez ensuite votre filtre.

Nom : Centre Plage : A1E6

D
TRIM3

C
REGIONS TRIM1 =l TRIMZ =]
NORD Trierde A — 2

Trierde Z — A

» Filtrer par condition_.

- Filtrer par valeurs
Tout sélectionner - Effacer v

a

~" CENTRE
)

coT

3. Cliquez ensuite sur la croix a droite pour quitter la vue qui est sauvegardee
automatiquement.

4. Lavue est maintenant disponible dans la liste “vue filtrée".

Dans l'exemple, nous avons un filtre qui donnera uniquement les valeurs de la région centre.

Pour supprimer ou dupliquer une vue filtrée, cliquez sur le bouton E] puis cliquez sur l'option
souhaitee.
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Filtrer des données pour le partage et la collaboration

Vous pouvez grace a des vues filtrées parametrer a l'avance des filtres pour les personnes
avec qui vous partagez vos fichiers Google Sheets.

ol I

REGI Créer une vue filtrée temporaire

- Centre {b il

Ouest

Cette fonctionnalité est notamment tres intéressante si vous souhaitez partager un fichier
uniquement en lecture, mais que vous souhaitez que les personnes puissent visualiser
rapidement certaines données. Méthode qui peut faire gagner un temps non negligeable.

De plus, méme si les personnes sont uniquement en droit d'acces “lecture” ils pourront creer
leur propre filtre avec l'option “Créer une vue filtrée temporaire”.

Attention : Seuls les personnes ayant des droits de modification sont autorisées a créer des
vues filtrées accessibles aux personnes qui peuvent consulter le fichier.
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Gestion des dates
Décalage d'une date de plusieurs mois

Dans le cas ou vous auriez besoin de connaitre la date d'une prochaine échéance se situant x
mois dans le futur ou dans le passé, vous pourriez avoir besoin de la fonction “EDATE".

Dans l'exemple ci-dessous, nous ajoutons 4 mois a la date du 7 Novembre 2015. Il est possible
de mettre une valeur négative pour obtenir une date passée.

- Incremente de 4 mois la date initiale : =EDATE("07/11/2015"4)
Il est egalement possible avec cette fonction d'avoir une date passee (Ex: “-4" au lieu de “4").
Calculer le nombre de jour (mois, année) entre deux dates

Pour calculer le nombre de jours ou encore le nombre de mois et d'annees entre deux dates,
il vous suffit d'utiliser la fonction “DATEDIF”.

Voici ci-dessous les trois cas d'utilisation de la fonction :

- Nombre de jours entre deux dates : =DATEDIF("08/10/2015","05/02/2016""D")
- Nombre de mois entre deux dates : =DATEDIF("08/10/2015""05/02/2016";"M")

-  Nombre d'années entre deux dates : =DATEDIF("08/10/2015","05/02/2016""Y")
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Fonction ArrayFormula

La fonction ArrayFormula permet d'afficher des valeurs issues d'une formule de tableau sur
plusieurs lignes et/ou colonnes, et ainsi d'utiliser avec des tableaux des fonctions non prise
en charge initialement.

Syntaxe d'ArrayFormula
La syntaxe se présente sous la forme suivante : ARRAYFORMULA(formule_tableau)

- Formule_tableau : Plage et expression matheématique utilisant une ou plusieurs plages
de la méme taille, ou fonction qui renvoie un résultat avec plus d'une cellule.

Utilisation d'ArrayFormula

Dans le cas ou je souhaite avoir la somme des résultats mensuelle de deux régions, il suffit
de spécifier les plages du Nord (B2:E2) et celle du Sud (B5:E5s). Soit la formule et le résultat
suivant :

=ARRAYFORMULA(B2:E2+B5:ED)
- A . B C D E
REGIONS TRIM1 TRIM2 TRIM3 TRIM4
NORD 120 130 123 157
CENTRE 130 135 140 145
EST 132 135 136 133
SuD 140 147 150 149
OUEST 147 146 150 157
NORD & SUD EBD. 277 273 306
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Fonction Importrange

La fonction Importrange permet d'importer une plage de cellules depuis une feuille de
calcul spécifique. La formule fait ainsi référence a la feuille d'origine (ou sont présentes les
données a importer), puis a la feuille et la cellule de destination (ou sont importer des
données).

Syntaxe d'Importrange

La syntaxe se présente sous la forme suivante :
=IMPORTRANGE("URL_du_Fichier”,"Feuille_et_Plage_de_données")

- URL_du_Fichier : récupération d'une partie de 'URL du fichier concerne.

https://docs.google.com/spreadsheets/df197L0adPGJbqu02U41Fp0j0cwGhGVVGOJYIWDXPbWO7M/edit#gid=0]

- Feuille_et_Plage_de_données : Feuille et plage a importer au format
“sheet_name!plage”.

Utilisation d'Importrange

Pour récupérer une plage de données (A1:E6) dans une feuille qui se nomme “Feuille1” et
qui a comme URL “1z_LX2XB2bYWkRMg31wGaZshIZABMJ2jmiOBcx1RHGak/ edit#gid=-0".

Il faut appliquer la formule suivante :

=IMPORTRANGE ("1z_LX2XB2bYWkRMg3 1wGalshIZABMI2 jmi0Bcx1RHGak/edit#gid=0"; "Feuillel!A1:EG")

Suite a linsertion de la formule, vous devriez avoir une fenétre qui s'affichera pour autoriser
'acces au fichier.

i Vous devez associer ces feuilles.

les données présentes dans le fichier d'origine doivent alors apparaitre.

=IMPORTRANGE ("1z_LX2XB2bYWkRMg31wGalshIZABMI2 jm10Bcx 1RHGak /ed1tfgid=a";"
A B C D E
REGIONS .I TRIMA TRIM2 TRIM3 TRIM4
MORD 120 130 123 157
CENTRE 130 135 140 145
EST 132 135 136 133
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Fonction VLOOKUP (RechercheV)

La fonction VLOOKUP permet de rechercher des éléements de facon verticale dans le
document en fonction d'une clé dans la premiére colonne d'une plage, et affiche alors la
valeur d'une cellule spécifiee dans la lighe trouvee.

Syntaxe d'Importrange
La syntaxe de VLOOKUP se compose de la facon suivante :
=VLOOKUP(clé_recherche, plage, index, est_trie)
- clé_recherche : valeur a rechercher. Ex : 17, "Voiture" ou A3.
- plage : plage a renseigner pour la recherche.
- index:index de colonne de la valeur a afficher.

- est_trié (facultatif, TRUE par défaut) : indique si la colonne sur laquelle s'effectue la
recherche est triee.

Information : Les performances de VLOOKUP sont meilleures dans le cas ou les plages
sont triees et lorsque est_trié est TRUE.
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Utilisation d'Importrange

Dans cet exemple, VLOOKUP recherche un identifiant d'étudiant dans la premiére colonne
et renvoie la classe correspondante.

Student ID Grade
N444 90
N333 100
N222 85
N111 a0

Student 1D Grade Formula
N111 a0 =VLOOKUP(A9,5A%2:3B35, 2, FALSE)
N222 85 =VLOOKUP({A10 5A52:5B%5. 2, FALSE)
N333 100 =VLOOKUP{A11,5A52:5B%5. 2, FALSE)
N444 a0 =VLOOKUP{A12 $A52:5B%5. 2, FALSE)

Dans ce deuxieme exemple, la fonction renvoie la premiére valeur identifiée lorsqu'il existe
plusieurs correspondances pour la valeur de la clé de recherche.

Guest Name Table Number  Dietary Restriction  Sent Invitation
David 2 Vegetarian No
Bob 3 None No
david 1 Naone Yes
MNancy 4 Naone No
Mary 5 Vegetarian Yes
Guest Name Dietary Restriction Formula
david Vegetarian =VLOOKUP(A10,5A52:3C$6, 3, FALSE)
Nancy MNone =VLOOKUP(A11,5A52:5C$6, 3, FALSE)
Mary Vegetarian =VLOOKUP(A12 $A%2:3C$6, 3, FALSE)

Information : pour réaliser le méme type d'analyse, mais sur des données horizontale,
utilisez la fonction HLOOKUP.
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La fonction Query

La fonction QUERY exécute sur toutes les données, une requéte écrite dans le langage de

requéte de 'API Google Visualization (similaire a du langage SQL pour les inities).

Syntaxe de QUERY
La syntaxe de QUERY se compose de la facon suivante :
=QUERY(données, requéte, en-tétes)

- données : plage de cellules sur laquelle effectuer la requéte.
- requéte : requéte a executer. Elle doit étre entouréee de guillemets.

- en-tétes (Facultatif) : nombre de lignes d'en-téte dans la partie supérieure des
données. Si cette valeur est ignorée ou correspond a -1, elle est déduite en fonction du

contenu de données.

Utilisation de QUERY

Voici ci-dessous deux exemples d'utilisation de la fonction QUERY :

1. Liste des étudiants qui sont “junior” et qui font de “l'art”.

=QUERY (Tableau! $A$2: 3E331; "select A where (C='Junior' and D="Art')")
A B c D E F
Nom Etudiant Sexe Matiere principale Activité extra-scolaire
Alexandra Female Senior English Drama Club
Andrew Male Débutant Math Lacrosse
Anna Female Débutant English Basketball
Becky Female Sophomaore Art Baseball
Benjamin Male Senior English Basketball Carl
Carl Male Junior Art Debate Lisa
Carrie Female Junior English Track & Field
Lisa Female Junior Art Lacrosse
Dorothy Female Senior Math Lacrosse

2. Calcule le nombre d’'étudiant qui sont “Junior”.
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=QUERY (Tablez

. "select count{A) where(C='Junior')")

A C D E
Nom Etudiant Matiere principale Activité extra-scolaire
Alexandra Female Senior English Drama Club
Carl Male Junier Art Debate
Carrie Female Junior English Track & Field
Andrew Male Débutant Math Lacrosse
Edward Male Junior English Drama Club
Anna Female Débutant English Basketball
John Male Junior Physics Basketball
Lisa Female Junior Art Lacrosse
Joseph Male Débutant English Drama Club
Pamela Female Junior Math Baseball
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Les graphiques

Google sheets propose eégalement de représenter la plupart de vos tableaux sous forme de
graphique.

Pour réaliser un graphique depuis un tableau, il vous suffit de sélectionner l'ensemble des
cases de celui-ci et de cliquer depuis la barre de menu sur Insertion > Graphique...

Fichier Edition Affichage Insertion =Format Données Outils  Modules col

& o~ AP € % i Ligne audessus ) - B T
157 Ligne au-dessous
A B 5 lignes au-dessus E

'REGIONS TRIM1 5 lignes au-dessous TRIM4

CENTRE 13 145

NORD 13 Colonne a gauche 157

sup 1¢ Colonne & droite 149

EST 13 3 - 133

S5colonnes a g
OUEST 14 157

5 colonnes a droite
Nouvelle feuille

B Commentaire Ctri+Alt+M
Remarque Maj+F2

Z Fonction

[E] Graphigue... {b

Editeur de graphique

Une fois sur la fenétre Editeur de graphique Google sheets va vous proposer un ensemble
de graphiques recommandés.

Vous pouvez alors sélectionner celui qui correspond le mieux a votre cas, ou encore choisir
d'autres types depuis l'onglet Type de graphiques.

Lorsque vous avez fait votre choix cliquez sur le bouton “Insérer” pour intégrer le graphique a
votre feuille Google Sheets.

Types de graphi P isati Aide

*Feuille TIAZEG
e = Column 1/ Column 2/ Column 3/ Column 4/

Column 5

Column 1/ Column 2 Column 1/ Column 2...

-
1 mEgl
mEmE

mmen EEEEE

EEE NN

Column 1  Column 2 Cotumn 1/ Cotumn 2

[ 135

=

=

=

o Az | 120

Column 1/ Column 2 Column 1/ Column 2.. I
105

—_—— CENTRE NORD sSuD EST OQUEST
—
f—e————— Column 1
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Modification et personnalisation d'un graphique

Suite a linsertion du graphique, vous pouvez modifier les différentes zone de texte en
cliquant dessus. Vous pourrez alors modifier le texte ainsi que la mise en forme (taille,
couleur, gras, italique).

B 7 16 - A~

P 3 ! Column 4/ Column 5§

Appuyez sur Entrée pour confirmer.

Column 1/ Column 2/ Column 3/ Column 4/
Column 5§ {b

160

D'autres possibilités s'offrent suite a l'insertion d'un graphique. Pour cela, cliquez sur la petite
fleche en haut a droite :

- Moadification avancée... . "Développe plus bas.

- Supprimer le graphique : supprime le graphique de la feuille.

- Enregistrer l'image : enregistre le graphique sur votre poste au format png.

- Publier le graphique : permet de publier le graphique sur une page web.

- Copier le graphique : créer une copie du graphique. (Ctrl+V pour le coller ensuite).

- Déplacer vers sa propre feuille... : Déplacer le graphique dans une feuille spécifique.

@
Column ©
Modification avancée. .. .

Supprimer le graphique

Enregistrer limage

Publier le graphique...

f Copier le graphique
Déplacer vers sa propre feuille. ..
[ ]

Texte alternatif...

N

87/125



Modification avancée

La modification avancée permet de personnaliser de facon plus pousseée votre graphique.

Graphique : vous pouvez modifier la mise en forme globale du graphique ainsi que le titre et
l'affichage de celui-ci (Fonctionnalites).

Graphique

Titre Bz | - -
Column 1/ Column 2/ Column 3 / Column 4
Légende

Intérieur  ~ B |Z|[12 +~ - -

Police Arial

Arriére-plan

Fonctionnalités

Empiler Inverser

Axe : permet de modifier le titre de l'axe, sa mise en forme, et notamment de modifier
l'inclinaison. Intéressant lorsque le legende et longue.

Axe Horizontal -

Titre B r 12 - N~

Column 1

Libelle de laxe B 7 12 - H-

Incliner les libellés Automa... -

Considérer les libellés comme du texte

Série : permet de modifier la mise en forme de chaque colonne ou ligne du graphique. Vous

pouvez egalement inverser le positionnement de l'axe de gauche a droite.

Série  Tous les Colonnes -

Axe Gauche -

Libellés de données

Aucun

Barres derreur

Aucun -

Information : Pour en savoir plus sur tous les graphiques et notamment les types de

graphiques pris en charge par la solution,

En
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https://support.google.com/docs/answer/1907187hl=fr&ref_topic=1361474.

Fonction Explorer

La fonction “Explorer” présente dans Google Sheets vous permet de

creer automatiquement des graphiques a partir d'un tableau que vous _

u Exp!c-rjlih

venez de réaliser.

e

Pour utiliser cette fonction, il vous suffit de cliquer sur le bouton

“Explorer” en bas a droite de votre document Sheets. Vous aurez ainsi différentes

propositions de graphiques a intégrer.

Explorer x

Dep 22, Dep 29, Dep 35 et Dep 56
Janvier
Février
Mars
Avril

Mai

“Février” contient la valeur la plus élevée
pour “Dep 22" (1982) et les valeurs les plus
faibles pour “Dep 35° (1200) et *Dep 56°
(1300).

Janvier
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https://support.google.com/docs/answer/190718?hl=fr&ref_topic=1361474

Impression et telechargement

Mise en page et impression

Pour imprimer, vous pouvez soit cliquez sur le bouton imprimante dans la barre d'outil ou
encore faire Fichier > Imprimer. \/ous aurez alors la fenétre de parametres d'impression qui va

s'afficher.

Vous pouvez notamment personnaliser le résultat de l'impression :

Options : spéecifier des options sur la feuille a imprimer comme choisir d'imprimer toutes la
feuille ou simplement une sélection.

Format de papier : choisir le format de papier en sortie.

Mise en page : choisir le type de sortie lors de limpression.

Paramétres d'impression

Options

® Feuille actuelle
Toutes les feuilles

Sélection

Format de papier

A4 (210 mm x 297 mm) %

Mise en page

)
Ajuster a la largeur

m Amake

Taille reelle

+  Répéter les en-iétes de ligne sur chaque page
Pas de quadrillage
Inclure le titre du document
Inclure le nom des feuilles
Inclure les numéros de page

®
Portrait Paysage

Ham
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Telechargement

Vous pouvez également télécharger le fichier en difféerent

format.

Il vous suffit pour cela de faire Fichier > Téléecharger au

format et de sélectionner le format souhaité.

Astuces & Notions diverses

Microsoft Excel (XLSX)

Format OpenDocument (.ods)

Document PDF (_pdf)

Valeurs séparées par des virgules (.csv, feuille active)

Valeurs séparées par des tabulations (.tsv, feuille active)

Page Web (.zip)

Dans ce chapitre, vous trouverez des notions pour aller plus loin dans lutilisation et la

comprehension de Google Sheets.

Recherche / Remplacement

Pour recherche des informations précise dans un fichier Google Sheets, dans la barre de
menu cliquez sur Edition > Rechercher et Remplacer (Ctrl+H).

Rechercher et remplacer

Rechercher

edition|

Remplacer par

Remplacer

Respecter la casse

Tout remplacer

< Prec. Suivﬁl >

Depuis la fenétre qui va s'afficher, vous allez pouvoir recherche des éléments dans tout le
fichier ou encore remplacer des mots. Pour cela, noter le mot a remplacer dans
“Rechercher” et le nouveau mot dans le champ “Remplacer par”.

Rechercher

Remplacer

Onglets

Remplacer par = Feuilles

Respecter la casse

Tout remplacer

< Préc.

Suivant >

Il ne vous reste alors plus qu'a remplacer les mots au fur et a mesure en cliquant sur le
bouton “Remplacer” ou tout les mots d'un clic avec le bouton “Tout remplacer”.
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Historique de revisions

L'historique de révisions vous permet d'accéder a aux differentes
etapes de creation de votre document. Vous pouvez ainsi revenir a
une version précedentes dans le cas ou les dernieres modifications
apportées ne sont pas valides.

Pour acceéder a linterface de révisions, cliquez dans la barre de menu
sur Fichier > Consulter l'historique des révisions ou sur le bouton
“Enregistrement en cours/Toutes les modifications enregistrés dans
le Drive” ou encore, faite la combinaison de touches “Ctrl+Alt+Maj+G".

Vous accéderez alors a linterface a droite de votre document. Depuis
cette interface, vous allez pouvoir sélectionner les différentes
étapes de modification du document, afficher ou non les
modifications en surbrillance et afficher les étapes intermédiaires
en cliquant sur le bouton “Afficher plus de détails”.

Mise en forme rapide

Historique des révisions x
L L

v Afficher les modifications

Afficher plus de détails

Pour copier la mise en forme (caractére, taille, couleur, ..) d'une cellule ou d'un ensemble de

cellules, utilisez licone avec le rouleau de peinture . Pour appliquer une mise en forme :

1. Placez vous tout d'abord sur la cellule a copier.

2. Cliquez ensuite sur le bouton.

3. Puis sélectionner la ou les cellule(s) ou appliquer la mise en forme.

Effectuer un collage spéecial

L'option collage spécial vous permet de copier des données de facon plus précise.

Coller uniquement les valeurs
Coller uniquement le format

Tout coller sauf les bordures

Coller uniguement les formules
Coller uniguement la validation des données
Coller uniguement la mise en forme conditionnelle

Coller avec transposition
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Vérifier l'orthographe dans une feuille

Pour vérifier si votre feuille de calcul ne présente pas des fautes d'orthographes et avoir des
suggestions de correction, utilisez le correcteur orthographique.

1.

2.

Cliquez sur la cellule ou les plages de cellules a vérifier.
Dirigez vous vers la barre de menu > Outils > Orthographe.

Si le correcteur trouve un mot qui lui semble incorrect, il va vous proposez le
remplacer. Si vous le souhaitez vous pouvez evidemment Ignorer la proposition.

Pour terminer la vérification cliquer la croix X.

Remplacer REGIONS par : b 4
REGIONS Remplacer =
+ REGIONS lgnorer -

REG IONS ! Ajouter au diction... =
REG-IONS

Sélecteur de date

Le sélecteur de date permet de choisir une date dans une fenétre pop-up de calendrier. Pour
afficher le sélecteur, il vous suffit de double-cliquez dans une cellule contenant une date.

10/08/2015

« aodt 2015 »
LMMIVSD
27 28 29 30 31 1 2
3 456 7 8 9
ET) 11 12 13 14 15 16
17 18 19 20 21 22 23
24 25 26 27 28 29 30
31 1 2 3 4 5 6

Pour étre sur que votre feuille soit bien au format jj-mm-aaaa. Dirigez vous vers Fichier >
Parametres de cette feuille de calcul pour vérifier les parameétres régionaux.

Garder la mise en forme des cellules

Si vous souhaitez copier des données d'une cellules ou d'un ensemble de cellule et garder la
mise en forme de la cellules ou de l'ensemble des cellules de destination, il vous suffit de
copier les données avec les raccourcis clavier “Ctrl+Maj+V".
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Tableau croise dynamique

Un tableau croisé dynamique vous permet de créer des rapports sous forme de tableau
dynamique qui vous permettent d'interpréter des données de difféerentes manieres sans avoir
a saisir de formule. Ces rapports sont particulierement utiles lorsque vous voulez restreindre
un ensemble de données volumineux ou analyser les relations entre différents points de
donnees.

Avant de voir en details l'utilisation des tableaux croisés dynamiques, voici des notions a
connaitre pour genérer correctement un rapport :

- Organisez vos données dans des colonnes.

- Les feuilles de calcul Google détectent automatiquement les plages de cellules pour
votre tableau croisé dynamique.

- Faites glisser les champs vers d'autres categories pour modifier rapidement et
facilement votre analyse des données.

- Vous pouvez creer plusieurs rapports sous forme de tableaux dynamiques croises a
partir du méme ensemble de données. Il vous suffit de repartir de la source de
données pour génerer un houveau rapport.

- Les tableaux croisés dynamiques crées dans Microsoft Excel peuvent étre importes et
convertis en feuilles de calcul Google.
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Créer un rapport en tableau croisé dynamique

Pour créer un rapport sous forme de tableau croisé dynamique a partir
des données d'une feuille de calcul, il faut procéder comme suit :

1

Depuis la barre de menu > Données > Tableau croisé
dynamique...

Saisissez alors le champ des données a prendre e compte.

Une nouvelle feuille va alors étre générée “Rapport de tableau
croisé dynamique”. Elle va contenir pour le moment un rapport
vide.

Dans l'éditeur de rapport (fenétre a droite), sélectionner les
champs a ajouter aux catégories Lignes, Colonnes, Valeurs ou
Filtrer du rapport.

Vous pouvez ensuite modifier l'organisation des données en
faisant glisser les champs vers d'autres catégories.

Editeur de rapports

!

Données!A2:D21 - Modifier la plage...
Lignes - Ajouter un champ

Grouper par : bureau X
Ordre : Croissant »
Trier par : bureau »

" Afficher les totaux

Colonnes - Ajouter un champ

Grouper par : Rdc
Ordre : Croissant »
Trier par : Rdc -

" Afficher les totaux

Valeurs - Ajouter un champ

Affichage : 3 *

Synthétiser via : COUNT -

Filtrer - Ajouter un champ

Information : il n'est pas possible d'ajouter un méme champ a plusieurs categories, car cela

entrainerait des doublons dans les calculs du tableau croisé dynamique.
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Tri, synthese et filtrage d'un tableau croisé dynamique

Suite a l'ajout des champs a votre tableau croisé dynamique, vous pouvez trier, synthétiser,
filtrer des donnees, ou encore ajouter des formules. Voici ci-dessous en détaill comment

procedez.
Trier des données

Vous pouvez trier les champs Catégories, Lighes et Colonnes en ordre
croissant ou decroissant. Pour modifier l'ordre, cliquez sur le menu
déroulant en bas d'un champ de la categorie Ligne ou Colonnes.

Synthése des données

Vous avez la possibilitée de trier les champs de la catégorie Valeurs par
fonction. Pour modifier l'ordre de tri, cliquez sur le menu déroulant en
bas du champ et sélectionnez l'ordre de tri des données.

Filtrage des données

L'ajout d'un champ depuis la catégorie Filtrer permet de masquer les
points de données que vous ne voulez pas voir apparaitre.

Pour filtrer les données de votre tableau, cliquez sur le menu déroulant
en bas d'un champ de la catégorie Filtrer. Cochez ensuite la case que
vous voulez afficher ou masquer.

Utilisation des formules

En plus de l'utilisation du tableau croisé dynamique, vous pouvez affiner

Grouper par : bureau
Ordre : Croissant -
Croissant

Décroissant
ux

Valeurs - Ajouter un champ

Affichage : 3 x
Synthétiser via - COUNT ~

SUM

COUNTA

COUNT

COUNTUNIQUE

AVERAGE

Filtrer : Tout sélectionner - Effacer b4

I Q

bureau

classe
info
v labo

remise

Annuler

votre analyse en saisissant des formules en dehors de votre rapport. Les formules vont traiter
les valeurs du tableau croise dynamique comme dans les cellules de données normales.
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Partage & Collaboration

Partagez votre feuille de calcul avec d'autres personnes et profitez des fonctionnalités
collaboratives des feuilles de calcul Google. Plusieurs personnes peuvent modifier une méme
feuille de calcul simultanément — la version la plus récente est toujours a portée de main.

Pour partager une feuille de calcul, cliquez sur le bouton Partager en haut a droite de la page.
Pour en savoir plus sur les paramétres de partage, consultez le document Partager et
collaborer.

Les régles de collaboration dans les feuilles de calcul sont legerement difféerentes de celles
applicables aux documents : une cellule ne peut étre modifieée que par une seule personne a
un instant T et chaque commentaire est associé a une cellule donnée.

Collaborer par modifications simultanées

La cellule que vous avez sélectionnée est surlignée en bleu. Si une autre personne modifie la
feuille de calcul en méme temps que vous, la cellule qu'elle a activée présente une bordure
de couleur difféerente.

Si vous voulez savoir qui a sélectionné une cellule, placez le pointeur de la souris dessus.

c D E 3
Fommn P o, E

wy W, T} mm m BT B

L

ST
s s o e LR ____|

o —
L NN L= B oo g O RS

Dans les feuilles de calcul Google, vous ne risquez pas d'écraser les modifications effectuees
par une autre personne. Une cellule en cours de modification apparait grisee.

S N NS e B

Si vous essayez d'éditer une cellule grisée, vos modifications ne seront pas prises en compte.
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Collaborer a l'aide de commentaires

Si vous étes autorise a commenter une feuille de calcul, vous pouvez ajouter des
commentaires dans des cellules individuelles.

Pour ajouter un commentaires, sélectionnez la cellule a laquelle vous souhaitez ajouter un
commentaire, puis Cliquez sur Insertion > Commentaire ou utilisez le menu contextuel
accessible par un clic droit.
| Mon tableau |
I . h

Commentaire sur le case. ..

Saisissez alors votre commentaire. Il sera automatiquement signeé de votre nom et horodate.

Cliquez dans une autre cellule. Vous pouvez alors constater que l'angle supérieur droit de la
cellule dans laquelle vous avez ajoutée un commentaire comporte un triangle orange.

Mon tableau
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Pour afficher l'ensemble des commentaires, il vous suffit de placer le pointeur de la souris
sur la cellule. Vous verrez alors la totalité de la discussion.

Eall II
l 15:;1_” Fermer la discussion :

Commentaire sur le case.

. 15:41 Aujourd™hui

Marquee comme fermeée

l 15:41 Aujourdhui

Rouverte

Répondre.

Si vous voulez modifier votre commentaire, cliquez sur la cellule, puis selectionnez
‘Modifier” ou “Supprimer”.

Pour répondre au commentaire d'une autre personne, saisissez votre réponse dans le champ
Répondez a ce commentaire qui s'affiche lorsque vous cliquez sur la cellule.

Une fois que vous n'avez plus besoin des commentaires associés a une cellule, cliquez sur
cette derniere, puis sélectionnez Fermer la discussion pour supprimer le fil de commentaires.
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Etre informé suite a une modification

Si vous souhaitez étre informé lors lors de la modification d'un fichier
Google Sheets partagé avec d'autres personnes, il vous suffit de
procedez comme suit :

Depuis le fichier Sheets en question, cliquez sur Outils > Regle de
notification.

Une fois sur la fenétre des regles de notification, il ne vous reste qu'a
spécifier la facon de notification qui vous convient le mieux.

Modules complémentaires A

Créer un formulaire

Galerie des scripts...

Editeur de scripts. .

Orthographe. ..

v Activer la saisie semi-automatique
Régles de notification.

Protéger la feuille de calcul...

Des modifications sont apportées.

Un utilisateur envoie un formulaire.
Je souhaite étre informé par...

E-mail (résumé quotidien)

E-mail (immédiatement)

Annuler

Je souhaite étre informé a I'adresse regis.lhostis_presta@triskalia.fr lorsque...
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Aide Google Sheets

L'un des fonctionnalités vous permettant d'en savoir plus est Aide relative aux feuilles de calcul
la partie Aide de la solution.

Aide

Signaler un probléme

Signaler un abus/un probléme de droits dauteur

Il vous suffit pour y acceder de cliquer sur l'onglet du méme
nom dans la barre du menu. Liste des fonctions

Raccourcis clavier Ctrl+/

Vous y trouverez notamment :

- Aide relative aux feuilles de calcul : Aide basique REEHZIEIEEEELEE
d'utilisation de lapplication. Vous pouvez renseigner une
question pour trouver rapidement une solution a un probléme.

!

Les plus lus

- LiSte deS thCtiOhS OUVI’e une page \X/eb Ou VOus trouverez =] Modifier et mettre en forme les données

une liste avec toutes les fonctions disponible pour i
[’appllcatlon 8 Configuration de la page
. . . . . . E Rechercher et remplacer du texte
- Raccourcis clavier ;. Tous les raccourcis clavier disponible
| o . E Modes d'affichage des feuilles de calcul
pour gagner un peu de temps lors de l'utilisation de Google ’
Sheets E Modifier la hauteur des lignes et la

largeur des colonnes

PARCOURIR TOUS LES ARTICLES [

101/125



Google Forms : Formulaires et enquetes

Environnement de Google Forms

La solution Google Forms de la suite Google Apps vous permet de réaliser simplement et
rapidement des enquétes et des formulaires de différents type publiable sur le Web. Vous
pouvez ainsi avoir l'avis de nombreuses personnes sur un sujet et analyser ensuite les
données sur un fichiers Google Sheets.
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Composition du menu de creation Google Forms

Un fichier de création de formulaire se compose de plusieurs zones spécifique. Voici un tour
d'horizon d'un fichier vierge avec de passer a la création d'un formulaire a proprement parler.

Zone de conception : permet d'agir sur la mise en forme, d'afficher les réponses ou encore d'afficher
la version publiée.

Palette de couleur : personnaliser le formulaire en sélectionnant une autre couleur ou un autre
théme parmi une large sélection.

Apercu : visualiser le résultat final du formulaire dans une autre fenétre.

Parameétres : permet de modifier des options comme les personnes autorisées a répondre et les
options de présentation.

Barre d'édition Google Forms : permet de choisir les critéres d'une question, d'ajouter un nouveau
champ, etc.

Envoyer : parameétres liés a la publication du formulaire.

Palette de couleur *_ & N

Zone de conception M’ é
i i Parameétres

Formula%%ade demonstration

Section 1 [-Bérre d'adition

Google Forms |

Question Texle
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Création d'un formulaire
Créer un formulaire

Pour créer un formulaire depuis Google Drive, il vous
suffit de cliquer sur le bouton Nouveau, puis Plus >
Google Forms.

Vous allez ensuite acceder a la page de creation de
votre formulaire Google Forms. Pour donner un nom
a votre formulaire, cliquez sur Formulaire sans titre.

Dossier

4

Importer un fichier

B e

Importer un dossier

Google Docs

]

Google Sheets

L= Google Slides

Plus

S

B coogleForms {t’)

Vous pouvez ensuite la renommer a tout moment en cliquant a nouveau sur le titre.

Créer un formulaire depuis Google Sheets

Pour créer un formulaire depuis Google Sheets : Menus, Insertion > Formulaire.

Un message indiquera la création d'un formulaire.
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Conception d'un formulaire

Barre d'édition du formulaire

La barre d'édition de Google Forms vous permet d'ajouter les éléments suivant a
la zone de conception :

&

Tr
- Une question
- Un titre est une description s
- Uneimage
- Une vidéo €
- Une rubrique (section) ==

Les questions

Apres la création du formulaire, ajoutez des questions auxquelles les interlocuteurs pourront
répondre. Vous avez acces a plusieurs type de questions possible. Pour ajoutez une
questions, cliquez sur le bouton +.

Les types elements

Pour choisir un élément particulier, sélectionnez le type de question en cliquant que la fleche en
face d”Ajouter un élément”.

. . Réponse courte
Vous avez le choix entre 4 types d’élément :

= Paragraphe

- Simple:
- Réponse courte @- Choix multiples
- Paragraphe _

. Complexe: Cases a cocher
- Choix multiples ° Liste déroulante
- Cases a cocher
- Listes déroulante ess Echelle linéaire

Mise en page :

- Echelle linéaire

- Grille a choix multiples
Horaires :

- Date

- Heure

e

Grille & choix multiples

Suite a la sélection vous pouvez agir encore sur la question, avec les éléments présents en bas de la
question ajoutée, soit :

- Rendre obligatoire la réponse a la question. [D [ obligataire
- Dupliquer la question.
- Supprimer la question.



- Les trois points verticaux : options supplémentaires spécifiques au type de la question.

Ajouter un titre

TT

Pour ajouter un titre au sein d'une rubrique, cliquez sur le bouton
description si vous le souhaitez.

, spécifiez le titre et une

Ajouter une image ou une video

Si vous le souhaitez, ajoutez un élément de type ‘média” comme une image ou encore une
video a votre formulaire. Ces types d'elements permettent d'aller plus loin en etant plus
précis sur les questions a poser.

Pour ajouter ce type d'élement, sélectionnez le bouton correspondant ou E depuis le

type mise en page.
Ajouter une rubrique (section)

[
Pour ajouter une rubrique spécifique dans votre formulaire, cliquez sur le bouton ™ présent
dans la barre d’édition de votre formulaire. Une nouvelle rubrique apparaitra comme
ci-dessous :

:

Section sans titre

Donnez un titre de section a la rubrique et si vous le souhaitez réduisez la taille de chacune

d’'entre elle en cliquant sur le bouton . Ceci vous permet de visualiser plus facilement les
guestions présentes dans chaque rubrique.

Le bouton Bvous permet quant a lui de réaliser les actions suivantes :

- Dupliquer la section
- Supprimer la section
- Fusionner avec I'élément supérieur (impossible pour la 1ére rubrique)



Passer a la section suivante

Accéder a la page 1 (Formulaire de démonstration)
Accéder 4 la page 2 (Section sans titre)

Accéder a la page 3 (Section sans titre)

Envoyer le formulaire

Accéder a une rubrique (section) selon la réponse

Certains types de questions permettent de diriger directement les personnes vers une autre rubrique
du formulaire.

Par exemple avec une question a choix multiples : -

- Siune personne répond “oui” elle accédera a la section Afficher

21 Texte de laide

- Sicest“non”, elle passera directement a la section 3.

W Accader 3 une section en fonction de la réponse

Question a choix multiples (@) Cholx multiples
Oui Acceder 3 la page 2 (Section sans litre)
Non Acceder 3 la page 3 [Secton sans fitre)
jouter une cption ou AJOUTER "AUTRE

Information : Il nest actuellement pas possible de rediriger vers une question sans créer au préalable un
saut de page.

Les réponses

Le menu réponse de votre formulaire vous permet de | amwmioes J
gérer en détail la facon dont vous souhaitez traiter les i
résultats.

Depuis ce menu, vous obtenez directement un résumé
des résultats sous différentes formes afin de bien i
interpréter et analyser le résultat. -~

Vous pouvez également :
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- Accéder au document Sheets associé avec le bouton
- Stopper les réponses au formulaire en décochant “Réponses acceptées”.

- Utiliser des options supplémentaires avec le bouton IEI:
- Sélectionner la destination des réponses
- Supprimer le lien vers le formulaire
- Télécharger les réponses (.csv)
- Supprimer toutes les réponses

Destination des reponses

Lors de l'envoi d'un formulaire a des personnes, vous pouvez choisir de récupérer leurs
réponses dans une feuille de calcul Google Sheets ou alors directement depuis le formulaire.

1. Cliquez sur le bouton @ présent dans le REPONSES

Réponses présent en haut du formulaire.

Sélectionner la destination des réponses {b

2. Puis Sélectionnez la destination des
réponses..

Supprimer le lien vers le formulaire

3. Sélectionnez alors l'une des deux options
proposees : Selectionner la destination des réponses X

Les réponses sond actuellement envoyées dans cette feyille de cale

o Nouvelle feuille de calcul B
o Nouvelle feuille dans une feuille de Do mianiimorey! Foonilsk deddooratrati:
calcul existante..

() Selectionner une feuille de calou existante

4. Valider par le bouton Créer.

Telécharger au format csv

Si vous souhaitez traiter les données ailleurs que depuis un document Google Sheets, vous pouvez
télécharger les résultats sous forme d'un fichier de type csv:

EI REPONSES
1. Cliquez sur le bouton =lprésent dans l'onglet
Réponses présent en haut du formulaire.

Sélectionner la destination des réponses

2. Puis Télécharger les réponses (.csv)

Supprimer le lien vers le formulaire

| 4u

Télécharger les réponses (.osv) 'i!b'

Supprimer le lien avec le formulaire

Lors de la collecte des réponses aux questions de votre formulaire dans une feuille de calcul Google
Sheets, votre Drive contient deux éléments associés : Le formulaire et |a feuille de calcul.



Vous pouvez a tout moment supprimer le lien entre les deux

fichiers depuis votre formulaire :

1. Cliquez sur le bouton Iﬂ présent dans l'onglet
Réponses.

2. Supprimer le lien vers le formulaire...

REPOMSES

Sélectionner |la destination des réponaes

Supprimer le lien vers ke formulaire

t Télécharger les réponses [osv)

Information : lors de la suppression de I'un de ces fichiers depuis Google Drive (formulaire, feuille de
calcul), le document associé n’est pas supprimé. Ainsi vous conservez la feuille de résultat aprés la

suppression du fichier Forms.

Supprimer les réponses a partir du formulaire

Vous pouvez supprimer les réponses d'un formulaire
directement a partir du menu Réponses.

Cliquez ensuite sur E puis sur le bouton Supprimer toutes les

réponses pour reinitialiser la feuille de calcul.

Changer de couleur ou theme

REPONSES

Sélectionner la destination des réponses

Supprimer be lien vers le formulaire

|4a

Télécharger les réponaes (.cav)

Supprimer toutes les réponses

Pour changer de theme ou simplement modifier la couleur de

fond du formulaire, cliquez sur le bouton Palette de couleur E Vous accédez alors a la palette de
choix d'une couleur. Pour personnaliser le theme plus précisément, cliquez sur l'icdne en bas a droite

de la palette

Sélectionner un theme

Dans la fenétre de sélection de theme, faites votre choix parmi une large sélection de theme:

- lllustrations

- Anniversaire

- Alimentation et restauration
- Feéte

- Pour les enfants

- Mariage

- Soirée en ville

- Sports et jeux

- Voyages

- Autres

Vous pouvez aussi importer une photos depuis votre
ordinateur et choisir un theme différent pour les
questions et les reponses au formulaire.

Setectonner un théme

. e
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Parameétres du formulaire

Parametres
Depuis le bouton parametre E] accedez a des options

permettant d'optimiser encore plus votre formulaire : Personnes autorisées a répondre

Tous les membres de Triskalia

- Personnes autorisées a répondre :
- Choisir si tout le monde peut répondre au e et et i M
questionnaire
- Autoriser une seule réponse [par utilisateur]
(connexion obligatoire) Page de confirmation

iapzage pour les personnes interrogs

Autoriser une seule reponse [connexion obiigatoire)

- Page de confirmation :
- Modifier le message recu aprés avoir réepondu au
formulaire.
- Possibilité de fournir un lien aux personnes
interrogées pour :
- Envoyer une autre réponse
- Modifier ses propres réponses
- Afficher le résumeé des réponses
- Options de présentation :
- Afficher la barre de progression ou non.
- Trier les questions en mode aléatoire ou non.

aux parsonnes interrogées un lien po
Ervoer une autre réponse
Modifier ses propres réponses

l:l Afficher le résumé des réponses a

Options de présentation
l:l Afficher |a bare de progression

I:I Trier les questiona en mode aléataire

Menu AUtreS I_EI Créer une copie

Vous pouvez notamment depuis ce menu :

- Créer une copie

- Déplacer le formulaire vers un autre dossier B  Placer dans la corbeille
- Placer le formulaire dans la corbeille

- Obtenir le lien de partage GD Obtenir le lien

- Imprimer le formulaire

- Ajouter des collaborateurs (éditer a plusieurs) Eli Imprimer

- Centre d’'aide (avoir plus d'informations sur la solution)

+2),  Ajouter des collaborateurs...

e Centre d'aide

n Signaler un probléme

Y Nouveautés



Partager et collaborer sur un formulaire

Sur Google Forms, vous pouvez partager et collaborer a plusieurs sur

un formulaire.

Pour ajouter des collaborateurs et ainsi activer le partage, cliquez sur
en haut a droite du formulaire puis sur “Ajouter des

collaborateurs...”.

Ajouter l'adresse des collaborateurs dans la zone ci-dessous :

Inviter des utilisateurs ;

Parametres resarves au proprietaire En savoir plus

personnes

Empé&cher les editeurs de modifier les autorisations d'acces et dajouter dautres

|_|:|. Craer une copie

il Placer dans la corbellle
G2 Obtenir le lien

ﬂi Imprimer

+a.  Ajouter des collaborateurs..

o+ [l

# Madification -

Lors de l'édition d'un formulaire en collaboration, chacun des utilisateurs ne peut modifier
qu'un seul champ a la fois. Si vous éditez une question, une autre personne ne pourra pas la

modifier en méme temps.

Envoyer le formulaire

Une fois votre formulaire terminé, vous pouvez le partager de plusieurs facons. Cliquez alors
sur le bouton “Envoyer” en haut a droite du formulaire.

Vous accedez alors a une nouvelle fenétre depuis laquelle vous allez choisir :

v Les personnes autorisées a répondre.

v Autorisées a répondre plus d'une fois
ou non au formulaire.

v Le mode de diffusion:

Email

Réseaux sociaux

Lien

Integrer a une page internet

o O O O

Envoyer le formulaire

Personnes aulonsees & répondre

Tout ke monda

— g
| | Aulorrser une HE‘JIR:' repanse (Connessn "_'Llllgﬂl."_':'t‘_l

Emvwayer via

E-mail

A

BEO
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Google Drawings : Dessin

Environnement de Google Drawings

Depuis l'application Google Drawings vous avez la possibilité de créer, partager et modifier
simplement des dessins en ligne.
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Composition du menu de création Google Drawings
Un fichier de dessin de type Google Drawings est composé des zones suivantes :
- Barre d'outils : toutes les commandes disponibles sont accessibles depuis ce menu.

- Barre d'édition Google Drawings : permet d'utiliser la plupart des outils disponible et
spécifique a l'application.

- Zone de dessin : zone de création du dessin.

- Collaboration et partage : bouton pour activer et géerer le partage et la collaboration
sur le fichier.

Dessin sans fitre kaia fr v
Fichier Edition Affichage Insertion Format Réorganiser Outils Tableau Aide \i ¥ CToms
= \EHa R\ G-Mm o A S
) Barre d'outils b
Barre d'édition iy
Google Drawings (collaboratlon et paﬂage}

\
N\
A\
N X

Zone de dessin
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Manipulation et notions de base

Création d'un fichier Google Drawings

Pour créer un dessin depuis Google Drive, il vous suffit de
cliquer sur le bouton Nouveau, puis Plus > Google
Drawings.

Vous allez ensuite acceder a la page de création de votre
formulaire Google Drawings.

Pour donner un hom a votre fichier, cliquez sur Dessin sans
titre.

Vous pouvez ensuite la renommer a tout moment en
cliquant a nouveau sur le titre.

Options de la barre d'outils

Edition

| Dossier

Importer un fichier

Importer un dossier

B Google Docs
Google Sheets
] Google Slides

Plus

>

B Google Forms

B Google Drawings

Permet d'effectuer des manipulation basique comme couper, copier, coller, dupliquer et

modifier une forme.
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Insertion

Permet d'utiliser la plupart des outils disponibles pour l'application.
Soit les elements suivants

- Zone de texte : gjouter une zone de texte au dessin.

- Image : inserer une image depuis une source externe.

- Lien:inserer un lien sur un elément du dessin.

- WordArt : gjouter du texte de type “WordArt".

- Trait : permet d'ajouter un trait de plusieurs type au dessin :
- Trait
- Fleche
- Connecteur en angle
- Connecteur en arc
- arc
- Polyligne
- Dessin a main levée
- Forme : permet d'insérer des formes spécifiques :
- Formes
- Fléches
- Légendes
- Equation

Insertion

Zone de texte
[aa] Image.

B Word Art
N, Trait
(i Forme

Tableau

B Commentaire

Ctri+Alt+M

- Tableau :insérer un tableau et choisir le nombre de lignes ou colonnes.

- Commentaire : permet d'ajouter un commentaire sur le dessin.

Information : lorsque vous étes en mode “trait” (fleche ou autre), vous pouvez continuer
a gjouter des traits jusqu'a se que vous repassiez en mode “selection” (bouton curseur de

souris) ou en appuyant sur la touche Echap de votre clavier.

Format

Le menu Format permet de modifier des éléements comme l'arriere-plan du dessin, et de

gérer la mise en page et l'ordre d'affichage de ceux-ci.
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Barre d'edition de Google Drawings

=B ale Qa kx\N-@a-fu H

La barre d'edition de Google Drawings vous permet d'insérer et d'agir rapidement sur votre
dessin. Voici les possibilites offertes par cette zone :

- Imprimer : lancez une impression du dessin courant.

- Annuler / rétablir des modifications ;: annule ou rétablie une action courante.

- Appliquer la mise en forme : applique une mise en forme existante a un élément.

- Zoom avant ou arriére : adapter la visibilité du dessin.

- Formes : insérer des formes diverses rapidement.

- Image : insérer une image depuis un endroit externe.

- Couleur de remplissage, de trait, d'épaisseur, ... : ces options sont disponibles une fois
qu'un élément spécifique comme une zone de texte est inséré.

-  Commentaires : insérer un commentaire sur le zone du dessin.

Information : si vous souhaitez dupliquer une forme, maintenez la touche Ctrl enfoncée tout
en faisant glisser la forme correspondante.

Modifier la taille du dessin

Pour modifier la taille de votre dessin, procédez comme suit :

1. Cliquez sur me menu Fichier > Configuration de la page.

2. Sélectionnez une taille depuis le menu déroulant, soit :

o

@)
o
©)

Standard (4:3)

Grand écran (16:9)

Grand écran (16:10)

Personnalisée : permet de préciser les dimensions de votre dessin et
sélectionner les unités correspondantes (pouces, centimetres, pixels).

X
Configuration de la page

Standard (4:3) 5

Annuler
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Mise en forme du dessin

Suite a l'insertion d'éléments sur votre zone de dessin, vous allez pouvoir modifier la mise en
forme de ceux-ci a l'aide des boutons presents dans la copie d'écran suivantes :

@-F == Al | 14 ~+~ B I U A-leo B | E-|IE-|E-i=-EE| L

Vous allez ainsi pouvoir suite a l'insertion d'un élements (forme, texte) :
- Modifier la couleur de remplissage et de trait.
- Modifier l'épaisseur du trait du style (tirets).
- Augmenter ou diminuer la transparence.
- Moadifier le style, la couleur d’'écriture et autres mises en forme...
- Ajouter des liens externes.

- Ajouter un commentaires sur un élément.

Information : pour modifier la couleur d'arriere-plan du dessin, faite un clic-droit dans la
zone de dessin puis sélectionner Arriére-plan et enfin la couleur souhaité.

[ Coller Cil+V
Arriére-plan
& Transparent

B Commentaire cirsarsy | NN
HEE BT

Sélection et manipulation d'objets

Manipulation de plusieurs objets

Pour sélectionner et manipuler plusieurs objets a la fois,
appuyez sur la touche Maj de votre clavier et faites ensuite
glisser la souris a 'emplacement souhaite.

Par exemple pour déplacer deux fleches a un autre endroit du
dessin comme dans le cas ci-contre.

Pour deéselectionner un objet maintenez a nouveau la touche
Maj et cliquez ensuite sur l'objet.
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Aligner ou faire pivoter la sélection

Suite a la sélection de deux élements vous pouvez egalement adapter facilement le
positionnement. Pour ce faire, faite un clic-droit sur les éléments “scindés”.

Vous allez alors pouvoir appliquer les options suivantes aux eléments sélectionnés :

Faire pivoter :
- 90’ adroite
- 90"agauche
- Verticalement
- Horizontalement

- Centrer sur la page (Horizontalement, verticalement).
- Aligner horizontalement.
- Aligner verticalement.

- Associer : scinde les images en une seul.

-  Commentaire : annoter un commentaire sur la sélection en

Cours.

Outre le clic-droit, vous pouvez également effectuer cette opération depuis le menu
Réorganiser. Dans le cas ou vous auriez seélectionné au moins trois objets, vous avez la
possibilité de les positionner a égale distance les uns des autres sur le plan horizontal ou
vertical en sélectionnant Réorganiser > Distribuer.

Vous pouvez egalement maintenir cette association en cliquant avec le bouton droit de la
souris sur l'un des objets puis en sélectionnant Associer ou depuis le menu Réorganiser >
Associer. Lorsque les objets sont associées, vous pouvez alors les manipuler comme s'il
s'agissait d'un objet unique.

Pour gagner un peu de temps, Vous pouvez eégalement utiliser les raccourci clavier :
- appuyer sur Ctrl + A pour selectionner tous les objets
- sur Ctrl + G pour associer des objets

- sur Ctrl + Maj + G pour dissocier des objets
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Déplacement, redimensionnement et rotation

Pour déplacer, redimensionner et faire pivoter un objet de votre dessin,
il vous suffit simplement de cliquez sur l'objet.

Vous verrez alors apparaitre un point de rotation en bleu, des poignees
de redimensionnement blanches ainsi que des poignées d'ajustement
de couleur jaunes.

Déplacement

Une fois un objet sélectionné, glissez le a l'aide de la souris ou des
touches flechées de votre clavier.

Si vous maintenez la touche Maj enfoncée pendant que vous faites
glisser l'objet, le déplacement suit l'axe horizontal ou vertical le plus
proche.

Redimensionnement

Sélectionnez et glisser l'une des poignees (blanches) de
redimensionnement. L'objet grossira ou rétrécira selon le mouvement
du curseur.

Les objets peuvent étre redimensionnés a l'échelle en maintenant la
touche Maj enfoncée pendant que vous faites glisser une poignée
d'angle.

Rotation

Sélectionnez et glissez le bouton bleu de rotation pour faire pivoter

l'objet. Si vous maintenez la touche Maj enfoncée pendant cette action,

la rotation se fera par incréements de 15",

Vous pouvez également faire pivoter l'objet de 90° en cliquant avec un
clic-droit sur l'objet a pivoter (horizontalement ou verticalement).

Remodelage

Les objets qui peuvent étre remodeles disposent de poignées jaunes.
Faites glisser ces poignées individuellement pour modifier la forme de
votre objet.

Information : Pour déplacer, redimensionner ou faire pivoter plusieurs objets en méme
temps, maintenez la touche Maj enfoncée pendant que vous cliquez sur chacun d'eux.
Vous pouvez également faire glisser votre souris sur larriere-plan du dessin pour

sélectionner plusieurs formes.
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Modeles pour Google Drawings

Pour vous faire gagner du temps dans la réalisation de dessin, de nombreux modeles
(templates) sont eégalement disponibles.

Pour accéder aux modeles disponibles depuis un nouveau fichier Google Drawings, cliquez
depuis la barre de menu sur Fichier > Nouveau > A partir du modele...

Vous pouvez ainsi avoir acces a un grand nombre de modeles public disponible gratuitement
par la communauté de l'application. Pour utiliser un modele trouvé, il vous suffit de cliquez
sur le bouton Utiliser ce modeéle afin qu'il se charge dans un nouveau document.

Autres ressources
Pour aller plus loin, voici des sites proposant des modeles pour l'application :

- http://ditchthattextbook.com
- http://appsusergroup.org
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Aller plus loin avec Google Drawings

Si vous souhaitez apprendre a maitriser pleinement le potentiel du l'application de dessin de
Google ou/et si vous doutez du potentiel de cet outil, je vous recommande daller jeter un
coup d'oeil sur le site de Joshua Pomeroy (http.//www.joshuapomeroy.com/) ou encore
d'apprendre par le biais de ses vidéos sur YouTube “Designing With Google™.

Voici un exemple des réalisations possible avec ces portraits :

Utiliser les outils bureautique Google

Comme vous avez pu le constater, les outils bureautique de Google permettent de réaliser un
grand nombre de chose. Les applications développées dans ce livre peuvent notamment
vous permettre de realiser, de suivre et de gérer de nombreuses taches applicables en
informatique.
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Voici ci-dessous quelques exemples d'utilisations pour utiliser chacune des applications
définies dans le livre.

- Google Docs : Des rapports, des offres, des notes de réunion...
- Google Sheets : Des feuilles budgétaires, des plans de projets, des listes de taches..

- . Des modules de formation, des présentations d'équipe, des
argumentaires...

- Google Forms : Des sondages, des enquétes de satisfaction...

- Google Drawings : Des organigrammes, des maquettes, des cartes
heuristiques/visuelles...
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Conclusion & remerciement

L'utilisation des outils bureautique Google permet d'acceder simplement a des outils devenu
incontournable au fil du temps. Cette solution présente des avantages non négligeable en
comparaison a d'autres applications plus connues comme la suite Office de Microsoft
présente depuis de nombreuses années sur le marché.

Cependant, la simplicité d'utilisation, les fonctionnalités de collaboration et de partage, des
mises a jours regulieres, ainsi que la gratuité de la suite pour les particuliers en font une
solution de choix pour le grand public.

J'espere que ce document vous aura permis de vous approprier les applications de la suite
bureautique de Google.

Bon courage avec vos projets bureautique !
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Informations legales

Cet e-book est protégé par le droit d’auteur et bénéficie d’'une protection au titre de la propriété
intellectuelle. Comme toute production de I'esprit, son auteur souhaite en recevoir une compensation pour
son utilisation. Il n’hésitera pas a faire valoir ses droits en ce sens si nécessaire.

Par conséquent :

> La copie partielle ou compléte des éléments de ce e-book n'est pas autorisée : toute reproduction
interdite.

> La modification de cet ouvrage est interdite.

> La vente ou revente de ce e-book est interdite.

Les droits des images jointes a ce document sont acquittés. Si une image de ce document vous
appartenait, veuillez nous contacter afin de résoudre le probléme dans les plus brefs délais.

Les marques citées dans ce document restent entierement la propriété de leurs détenteurs, si vous
souhaitez les retirer, contactez-moi.

Ce document a été congu pour que les lecteurs obtiennent un maximum d’informations. Le lecteur doit
cependant étre averti que les résultats obtenus (qu’ils soient positifs ou négatifs) dépendent uniquement de
I'utilisation qui sera effectuée de I'information contenue et que I'auteur ne peut étre tenu pour responsable
de ces résultats et décline toute responsabilité a I'égard des conséquences éventuelles de I'utilisation du
document.
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Ressources

Voici ci-dessous des sites internet ressources pour aller encore plus loin dans votre maitrise
de GSuite :

e Numeriblog: http://thierryvanoffe.com

e Numeritube : https.//www.youtube.com/channel/UCuVWopl83QgawEaNepFLlh7A

e F[astlearner : https.//www.youtube.com/channel/UCYRZOPIFkHAt_Nw7mTTOP5Q

e Deécouvrir GSuite : https://gsuitefr.blogspot.com/

e MyChromebook : https.//mychromebook.fr/

e https.//www.windtopik.fr/blog/
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